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Major
CheckPoints

Intro

to

RDWorks

1. Welcome to

Laser

Installation

An American Company Supporting
Top of the Line Lasers from C0 to

Galvo-Fiber to Deep Metal Cutting!

Installation Video |

RDWorks Training

“ Xy g

WATCH FOR THIS:

RDWorks 1. Welcome to TRAINING DATA COVERED HERE: 2. Our Main Staff 2-) k?serLLi"e 4.Support
. A) The Main part of our aser Line ranges
RDWorks: - INTRODUCED YOU TO THE COURSE. Staff is our Post Assembly from our entry LS 1426 to Call us at
and Q.A. Teams. the Class 4 LS 5298 to ’ i
2. Our Main Q)Dv\\;\ellgﬁgef;?, the . PRESENTED THE RDWORKS TEAM. a)syézlcg{:ﬁggir’iﬂon is thedli\i/lbell'(.'\/letal ?utting Engraver's Choice
. and Marking units.
Staff Lasers: the Technicians and B) The Hygrid units is from 8 PM to 8 'PM
a purpose of this - SHOWED OUR SUPPORT VEHICLE. App]gaglonstfxr\;\?n;.fee one of our larger enclosed ~ Monday thru Friday
our bBio on the Vvebsite H H
Tutorial Manual and catch our on-line E:Zigw:nc;;r;?:ﬁ?sﬁéng and 10-2 on
. WELCOMED YOU TO RDWORKS. training sessions. Saturdays.

3. Laser Line

4. Support

and its Instructional
PDF Fliers is not
only get the unit up
and running, but for
you to make
money with it.

B) There will be a
series of One page

“Tip”

C) | am Joe Braga | have
owned engraving and sign
operations and run
technical support for many
of the manufacturers out
there. Catch my ‘Bio’ at
www.engraverschoice.com.
We are a balanced team
and have Demo sites
throughout North America
and are here to help. Call

platform of 36 x 50
inches, with up to 180W
of power.

C) T20/50W fiber laser
enables you to
permanently mark or etch
firearms, tools, parts,
jewelry, bar codes, serial
numbers, industrial
polymers, etc. When you
call just inform us of what

We provide Phone
and PC-2-PC
support as well as
the Video Packages
and Onsite service.

The Laser can run from any Software
through the RDWORKS Interface or
Power Cell. We support it from Corel X3
sheets of data or or better and from EngravelLab. These

. : Packages are the Backbone of the Pricing and Shop marketin
Sample JObS to train Industry and are in most of you% individuaFI) product 9
you. shops throughout the world. lines.

C) This, in concert
with the Corel or
EngravelLab
Graphics courses
and the On-site or
PC to PC training,
should have you
very proficient in no
time. Installation is
the most important
job we do at
Engraver’s Choice,
now let’'s move
forward.

us anytime to instruct you
with whatever questions
you may have from
Software to Hardware to

subjects with
Videos and add-on

you have or text us your
questions. Most questions
will be software related to
either Corel, EngravelLab
or RDWorks interface.

Key Steps to our Goal

Main Task: Intro to BOSS 3: We cover areas just for
that Subject.

1: This section will be used to

show the Main Keystrokes for

the main Tasks.

4: We will talk about
Commands that we will need
to complete the task at hand
2: We only cover the
Keystrokes for the Major
Features shown on the Page.

5: We hope this will be helpful
in simplifying the process.

Figure 2

N
@)« Video: A1




RDWorks Training
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WATCH FOR THIS:
Saftey Checklist
Figure 1

. Figure 4
Figure 3
5 Level the Laser with
Major the @ottom Pad Mounts

CheckPoints

Unpack &
Inspect

4:5 Fume Exhaust Ports

Unpack &
Inspect

1. Pre-
Installation
Sheet

2. Uncrate &
Tie-Straps

3. Position
Laser &
Inspect

4. Safety &
Check the

Leaming the Safety Precautions is

Critical to you and the operation

1. Pre-Installation
Sheet:

A) There is a Pre-
Installation Sheet
that has a Check-
list of the items that
we will go over.

B) You will get the
Laser unpacked
and in place,
Inspect it, load
drivers and run
tests.

C) Check the unit
and prepare it for
training and final
installation. We will
being training on

of the Laser.

TRAINING DATA COVERED HERE:
BE CAREFUL. LASER MACHINES ARE POWERFUL TOOLS
DESIGNED TO CUT OR ENGRAVE WITH HIGHLY FOCUSED HEAT
ENERGY. NEVER LEAVE YOUR LASER UNATTENDED AND NEVER
LET ANYONE UNFAMILIAR WITH YOUR MACHINE OPERATE IT.
ALWAYS KEEP ACCESS COVERS ON AND TOP LID CLOSED.
AVOID ANY DIRECT EXPOSURE AND NEVER STARE AT THE
LASER LIGHT WHILE OPERATING. READ AND UNDERSTAND ALL
OF THE WARNING LABELS ATTACHED TO YOUR MACHINE. ALL
SAFETY MEASURES MUST BE STRICTLY ENFORCED AND
ABIDED BY. BOSS LASER SHALL NOT BE HELD RESPONSIBLE
FOR DAMAGES OR INJURY RESULTING FROM IMPROPER USE
OR DISMANTLING OF THE LASER MACHINE.

“Tip”
In Case of Fire:

1.Press the EMERGENCY STOP button
located above the LED Panel

2.Lift the lid

Double Single Hook-ups
e @

Installation Video Il

2. Uncrate & Tie-

Straps

A) Plug into 110 or 220
VAC electrical Outputs
LAST. We have a 6”
Portal for the Laser
Exhaust. When un-crating
the Laser remember to be
aware there are many
items inside.

B) Uncrate the laser and
roll it into place. Then go
through the Shipping
checklist to verify all
components are there.
You must remove the tie
straps or tie downs from
the Motion System.

C) Recheck the pre-
installation checklist and
verify that all items were
received, intact and not
ship damaged, especially,
the Laser tube. If the
Checklist is complete

3. Position Laser
& Inspect

A) Once rolled into
place, evaluate that all
the internal tie-straps
are removed, so the
motion system can go
to the home position
for the first time. Now,
look to see that you
are prepared to start to
do the hook up of the
hoses and cables.

B) Recheck that all
packing is removed.
Pull the Bridge of the
motion system to and
away from you.

C) Now push the Lens
Carriage to the left and
Right, Mount the Lens
if needed to the
Carriage assembly.

4. Safety & Check
the Tube

A) Read Safety
requirements in the BOSS
Manual. Now look at the
Tube and see that there are
two electrical connectors of
different types on each end.
B) The Tubes beam points
at the First mirror about 1/4
away from the mirror. The
Connectors are aligned so
that we can not get it in
backwards.

C) Check the tube hoses
for the water chiller you can
secure them with tie straps.
The Tube should have Duct
tape wrapped around it in

*NEVER operate laser
machinery unless you
have been properly
trained.

*ALWAYS use
protective eye-wear,
*ALWAYS turn the
Exhaust Fan on while
running the laser.
*NEVER sit anything on
top of the laser.
*NEVER leave the laser
unattended. Remain
with the machine when
it is running at all times
*ALWAYS keep the
machine’s environment
free of heavy pollution
such as strong
magnetic-electrical
interference.

*NEVER use
unapproved or unsafe
materials, such as
Polyvinyl Chloride
(%"}

*NEVER operate the
laser near flammable
and explosive
substances. The UV

Tibe the Lager 3.Quickly blow out the flame (or use a move forward to the next Remove all extra two places, Thls is Wher§ light beam that is
Operations CO2 fire extinguisher for serious flames, section. . you clamp to it and level it. . X .
P ’ but do this ONLY as a very last resort) grease from the rails. emitted is not visible
Pendant, — and poses a great fire

Video: A2

LaserWorks and
more than likely
Corel or
EngravelLab. We
will complete the
Applications
Training and Dial
the machine in for
the major materials
that you will
produce.

Figure 1

Figure 2

Figure 2

Figure 3

Figure 4

Key Steps to our Goal

Cut any bands. Then carefully remove

the top lid. Be careful not to use any
(elelgy] part of the plywood interior for a focal

point on pry bar. Stay on the outside

Main Task: Unpack
Make sure you are ready with
necessary tools and plenty of
for laying out the parts and

accessories of your new laser. Our
crates are usually banded to a
wooden pallet for safe shipping. If

you see any damage such as
or broken plywood take a picture
before removing bands. If it looks
smashed or opened take more
pictures. The machine is insured for

its value and may be damage
crate is badly damaged.

pierced

d if the

framing to ensure not piercing plywood
and damaging machine. Once the top
lid is off, look inside and find any loose
boxes containing accessories. Remove
any box that may fall when sides are
removed. Remove front panel and then
two side panels, then the back panel.

Save the crate panels in the event you
ever need to move the machine again.

hazard.

*NEVER open the
upper cover of the laser
machine while it is
running & NEVER
engrave a shiny metal
or mirror. The laser
beam can reflect and
deviate

*NEVER push or pull
the laser head and its
gantry while the laser is
running.

*NEVER dismantle the
laser machine. There
are laser and high
voltage/pressure parts
that could cause harm
or injury.

PG-2




Major
CheckPoints

Attach Hoses
& Cables

1. Mount Tube

to Laser

2. Hook-up
Hoses

3. Fill Chiller &
A/C Connect

4. Recheck All
& Power-up

< Video: A3

Chiller Side: Water OUT ----to ---Laser Side Water IN
Chiller Side: Water IN ----to ---Laser Side Water OUT

Figure 3

Attach Hoses
& Cables

Hooking the Hoses and A/C Cord up

Use a Small Heat Gun or Hair Dryer to Soften

Hose to get them to Fit onto the Barbed Outlets

1. Mount Tube to
Laser

A) Normally, the
Tube is already
mounted in the
Laser, but if you
need to mount it is
this simple.

B) Mount the Tube
so the beam points
at the first mirror
about 1/4” away
from the first mirror.
Now connect the
Electrical
connectors and the
hoses for the water
chiller either with tie
straps or clamps.
C) The Tube
should have tape
wrapped around it
in two places, so
you can screw the
clamps in around
the wrapped taped
areas (2) of the
tube. Adjust the
gap of the Tube to
the mirror from 1/4”
to 1/8” and tighten
the clamps screws
in. Make sure the
Tube is Level and
put the Cover down
and you are done.

Figure 1

TRAINING DATA COVERED HERE:
BE CAREFUL. LASER MACHINES ARE POWERFUL TOOLS
DESIGNED TO CUT OR ENGRAVE WITH HIGHLY FOCUSED HEAT
ENERGY. NEVER LEAVE YOUR LASER UNATTENDED AND NEVER
LET ANYONE UNFAMILIAR WITH YOUR MACHINE OPERATE IT.
ALWAYS KEEP ACCESS COVERS ON AND TOP LID CLOSED.
AVOID ANY DIRECT EXPOSURE AND NEVER STARE AT THE
LASER LIGHT WHILE OPERATING. READ AND UNDERSTAND ALL
OF THE WARNING LABELS ATTACHED TO YOUR MACHINE. ALL
SAFETY MEASURES MUST BE STRICTLY ENFORCED AND
ABIDED BY. BOSS LASER SHALL NOT BE HELD RESPONSIBLE
FOR DAMAGES OR INJURY RESULTING FROM IMPROPER USE
OR DISMANTLING OF THE LASER MACHINE.

“Tip”
Chiller Hoses:

1.Chiller OUT to Laser IN
2.Chiller IN to Laser OUT

3. Chiller Signal outlet must
attached on both ends or laser
will not Fire.

CW-3000
WOUSTRIAL iy

Figure 2

to the Laser and Machine homing the unit..

2. Hook-up Hoses
A) The water pump requires
two lines; one to the water in
and one to the water out
barbed fixture. Most Boss
Lasers tubes are water
cooled and the laser
machine will not fire if water
is not flowing. Make sure to
not get the lines reversed.
B) One Hose goes from
OUT of the Chiller side to the
IN of the Laser side, the
second hose IN on Chiller
side and to the OUT on
Laser side. Plug the Chiller
Signal outlet in on both
sides, without this the laser
will not fire.

C) The Air pump hose needs
to be attached to the Air inlet
fixture. Now attach the two
Exhaust Blower hoses from
the Laser to the blower with
clamps, then from Exhaust
blower to the to the wall
outlet. Attach the external
ground designed to help
eliminate static electricity.
Just run the included ground
wire from the connection to

Figure 2

Installation Video lli

3. Fill Chiller &

AIC Connect

A) Open the Tank Cap
on the top of the Chiller
and with a Funnel, Fill
the Chiller tank with 2-5
gallons of DISTILLED
water depending which
chiller you have, and
replace cap.

B) Plug in Chiller A/C
power cord into the
Laser Surge Protector,
and the Air Pump and
Exhaust Blower Power
Cords into another
Surge Protector.

C) Next after a final
recheck, Plug the
‘|sobar’ Protectors for
the Laser - Chiller along
with the PC or Laptop
Power Cord(s) into a
Dedicated A/C outlet

Figure 3

4. Recheck All &
Power-up

A) Review all items, check
that the Motion System is
free moving on both X & Y
Axis._Check that the tube
has its Silicon White
covers over its ends to
keep arcing from
happening.

B) Turn on the Chiller, then
turn on the Surge protector.
Turn on the Laser and PC.
C) All should be on, the
Laser Pendant should light
up. Walk around the laser
and listen for arcing. Now
press the ‘RESET’ button.
The Pendant and the Laser
will move to Machine Home.

Figure 4

Key Steps to our Goal

Larger machines with two exhaust ports;

Main Task: Exhaust Hoses
The exhaust requires the most

effort and its importance can't be
overstated. The laser vaporizes
material as it moves along its
axis, generating large amounts of
smoke. The exhaust is necessary
to remove this byproduct. Duct
exhaust to the outside, away
from any area where co-workers
may congregate. Correctly
ducted, a laser can easily be
placed in an office or spare room

the top port with flange is designed to
remove air from above the material
during engraving/etching for example.
This is the most common of exhaust
outlets to use. The lower port is designed
to draw air from below the material,
during cutting for example. First, this port
also removes air and all associated
debris from the working area as soon as

possible. Second, this lower unit will act

as a vacuum to hold down light material
such as cloth or paper. Notice there is no

WATCH FOR THIS:

Air Pump
Figure 1

The purpose of
the air pump is to
blow air through
the laser head
therefore blowing
debris and smoke
away from the
beam, while
allowing for
cleaner cuts and
protecting the
lens. The air
pump on/off
switch should
also be close by,
and preferably on
the same circuit
as the water
pump and
exhaust fan to
ensure its

operation when
running the laser
machine.



Major
CheckPoints

Testing Laser
& Drivers

1. Test Motion
System &
Focus

2. Set Origin &
Test Fire

3.Install
LaserWorks/
USB Driver

4. Install
Power Cell
Driver

N
)¢

Video: A4

igure 3

[ Z move ] I Language+ ]
[ U move ] [ rpsewp+ |
| Axis reset+ I [ Di gnoses+ ]
I I

[ Screen Origind J

Origin set+
Set Fact Para
Def Fact Para

Auto Focus

FOCUS

Testing Laser
& Drivers

Hooking the Hoses and A/C Cord up

to the Laser and Machine homing the unit.

1. Test Motion
System & Focus

A) With the Laser on
& the Pendant lit up,
use the Arrow keys to
jog the laser carriage
around, then hit
‘Reset’ to Datum the
laser.

B) Now Jog the laser
carriage over some
Laser-able Material
with the Plunger over
the Material, as well.
Then hit the Z/U
button on the
Pendant, press the
left or right arrows;
you will see the table
move up and down,.
If you are 2.5 inches
from the material, you
are in Focus. See that
the plunger is a little
below the Air-Nozzle,
this is important..

C) When you hit the
Z/U key the Pendant
screen will change.
The Auto-Focus icon
is on the bottom of
the Screen, arrow
down to it and hit
‘Enter’. The Table will
rise to the Focus
Plunger and return to
2.5 inches from the
Lens; No Focus — No
Burn.

Figure 1

Sy

Training Data Covered Here;
. TESTED THE LASER’S MOTION SYSTEM
. TESTED & FIRED THE LASER TUBE.
. SET AN ORIGIN FOR POSITIONING.
. LOADED THE LASERWORKS GRAPHICAL INTERFACE.
. LoAapeED THE USD DRIVER
. LoAabeD THE CORELDRAW POWER CELL.

O0NWN-—

. You will have to Acrylic
. check this with the Manual
Acrylic Manual Focus Tool

Tool

“Tip”
Plug-in software support a
version from CorelDrawX3 to
X7. The installation of
CorelDRAW X7 to introduce
the installation process of
plug-in software.

Laser Pendant l

£ u

[ i l ..
'
Min- Max-
@ ' 'I.

Laser Beam Seat | [Track

Datum
Will Fire Positioning \“Layou(
\

Laser

In Z/U Left/Rgiht
Arrows for Up/Dowi
Figure 2

Inside cabinet door on
right side of laser

Install USE driver

Type

Language:

[JPen drawing lines
Flug Laserfork

Tnstall |

Welcome to use

[JLocate install path

Unistall USE
Type
Lazerfork b4 Language:
Faglish v

[ tastan

Welcome to use

Install USB driver

[[JLocate install path
[JPen drawing lines
[1Flug LaserWerk

Uni stall USB

Corellra Laser v

Englizh v

Exit

Exit

Installation Video IV

2. Set Origin &

Test Fire
A) Jog the Laser
Positioning Light to the
Top/Right Corner of your
plate and hit the ‘Origin’
Button on the Pendant.
B) The Laser will begin
the fire from this point.
Either working top to
bottom in Scan or Raster
or Bottom to Top, as you
will control.
C) Next move the Red
Position Diode Light to
the Center of the
material. Now hit the
‘Pulse’ button and the
Laser beam itself should
fire. Once the beam fires
it shows that the Laser
tube is operational.
Hook the USB cable to
the Laser and to the PC
or Laptop. Check the
laser to see if the Chiller
is working.

Figure 2

3. Install
LaserWorks/USB
Driver

A) Either insert the
CD that came with
your BOSS laser or
get the Software from
the BOSS Laser
support site.

B) Install the
LaserWorks software
for English and the
open LaserWorks
and Close.

C) Next, Install the
USB Driver at the top
of the Dialog. This is
the main Interface
LaserWorks and

USB Driver that
allows you to send
data to the laser via
USB.
Figure 3

4. Install Power
Cell Driver

A) Load the Full
Power Cell for
CorelDRAW or
Engravelab.

B) Do not have
CorelDRAW or
EngravelLab open
and once it is
complete you can
close the installer
completely.

C) All the Drivers
and interfaces are
loaded and we
are ready to align
the Full Power
Cell within Corel
or Engravelab.

Figure 4

Key Steps to our Goal

Main Task: Laser Pendant
RESET: Datum or Reset whole

Laser System.
Origin:
Pulse:

Beam to the Material

Frame:
of the Layout.

Set Relative Starting
Point to the Laser Layout

Track around the outside

Star/Pause:

to the Laser

Pulse or Fire the Laser

File: Pick up File Download to the
Laser or Udisk

Start or Pause a Job Downloaded

Left / Right Arrow Keys:
JOG the Lens around
the Table via the Motion System.

Up/ Down Arrow Keys: To move
AL the Table Platform up and Down to
focus to the Material.

WATCH FOR THIS:
Install Laserworks
Figure 1

1. Install/Uninstall USB
driver:

2. According to the
different customer
application needs &
the habit of using
a)LaserWork.

b.The software that
plugs-in to CorelDraw
x3-x7

c.The software that
plugs-in to AutoCad.
Support the version
from 2004 to 2010.
d.The software that
plug-ins to lllustrator.
3. Choose a different
installation language
4. Select the software
that matches the
motherboard

5.Locate install path
When installing
LaserWork, default
install path is, to
change the install path,
check this option.

6. Pen drawing lines
This option is only
applicable to a
particular machine,
which has the function
of the chalk line,
ordinary machines do
not need to check this.
7. Plug laserworks

The installer default
install is a special plug-
in RDPlug. If the users
are more accustomed
to using LaserWorks
program you can check
this.




Major

CheckPoints

Testing Corel
Power Cell

1. Test Power

Cell

2. Create a
Test Job

3.Download a
Test Job

4. Run the
Test Job

N
)¢

[ gf Options...

Video: A5

Figure 3

Testing Corel
Power Cell

Ctrl+)

IEE Customiz] o
I Save Setti

Color Ma
Pronf Col

weoaEnAmw ]

0§ co

Color Management

Droof Colore

Training Data Covered Here;
| . TESTED THE POWER CELL ICON
2. CREATED A TEST JoB
3. DOWNLOADED TEST JOB TO THE LASER.
4. RAN TEST JOB ON THE LASER.

1.Test Power Cell

A) To Test the Full
Power Cell we first
must get our Power
Cell Icon to the
Standard Bar of
CorelDRAW or
EngravelLab.

B) In Corel, click
‘Tools’ Pull-Down
Menu and click on
‘Customization’.
Then select
Commands and
within that Dialog “Tip”

select Macros. You can have two LaserWorks
C) Now Highlight Icons for the Power Cell and
the LaserWorks One to Drop the layout

Icons and Drag directly into LaserWorks Main
them to the main Graphics Interface Program.
body of Corel.
Click ‘OK’ and
Drag the icons to
the Standard Bar at
the top. This is the
Case for both sets
if needed. Click on
the Icon to show
that the Power Cell
opens. Shut the
Power Cell down
and click the

U ) o e e e
and click the ‘Save

Defaults’to getthe  patim
icons to remain.

Laser Pendant

Laser Beam Seat Track
Will Fire Positioning  Layout

Figure 1 Figure 2

Installing and testing the P@wef Cell

RDWorks Tralnlng

=
=
5 =

)

For CorelDraw, AutoCad, Adobe & EngraveLab

Installation Video V

2. Create a Test

Job

A) In CoreIDRAW click on
the Property Bar and make
your Plate Size 2x4
landscape.

B) On the TOOLBAR click
the Text icon and click in
the middle of the plate and
Type ‘BOSS Laser and
then click on the Pick Tool
at the top of the
TOOLBAR.

C) Grab a corner node and
then Click and HOLD to
Resize the Text. Now hit
the ‘P’ key on the
Keyboard to center the text
to the Plate. Whatever
Font you have is fine.

Next Click on the
Rectangle Tool & put the
mouse cursor in the top/left
of the text , Click on hold
the flt mouse button and
pull down & across to
surround the text and let
go. Save the Job under
the ‘File’ Pull-Down Menu.

Figure 2

3. Download a
Test Job

A) Click on the
LaserWorks Icon in
Corel and activate the
LaserWorks Power
Cell.

B) In LaserWorks, drag
a selection Marquee
box around the text and
click the Black swash
on the Color pallet to
the Right. Then select
just the box around the
text and click the RED
on the Color Pallet to
the Right.

C) On the Control
Panel RED to Cut and
Black to Scan, Put in
your Power & Speed
Setting and click the
‘Download tab on the
bottom right.

Figure 3

4.Run the Test Job
A) Now check to see that
the job is at the Laser
and jog the Red
positioning Light to the
Top/Right corner of you
material and hit the
‘Origin’ key.

B) Next press the ‘Frame’
Key and the Red light
should track the material.
C) Last hit the ‘Start’ key
on the Pendant and the
Laser will begin to Scan
or Raster first based on it
being at the top of your
list in the Power Cell and
will Cut or Vector last. If
there is a flame-up just
stop the laser or open the
top door only.

Figure 4

Key Steps to our Goal

Main Task: Laser Pendant
RESET: Datum or Reset whole

Laser System
Origin:
Point to the Laser Layout

Pulse:
Beam to the Material

Frame:
of the Layout

Set Relative Starting

Pulse or Fire the Laser

Track around the outside

Star/Pause:
a Job Downloaded to the Laser

File: Pick up File Download to the
Laser or Udisk

Start or Pause

Left / Right Arrow Keys: JOG
the Lens around the Table via the
Motion System.

Up/ Down Arrow Keys: To move
the Table Platform up and Down to
focus to the Material.

WATCH FOR THIS:
Corel Macro
Figure 1

For some
versions of
CorelDraw
(such as green
version) may
not
automatically
navigate to the
location where
CorelDraw is
installed. Only
need to check
“Locate install
path” on the
installation
software, and
then manually
browse to
Folder
navigation.
Exit the
installation
program, and
run CorelDraw.




Major
CheckPoints

Laser
Pendant &
More

1. Laser
Pendant &

IP address:

B =) ] [

Gateway:

Figure 3

Laser Pendant
& More

Press Z/U move item

Modified press Enter

1. Laser Pendant
& Auto-Focus

Z move
U move
Axis resets
Manual Set+
Laser Set+
Origin set+
Set Fact Para
Def Fact Para

Auto Focus

[

Language+
.
Testing the Laser Pendant

and set Defaults

Training Data Covered Here:

. LEARNED ABOUT THE PENDANT CONTROLS

Installation Video VI

2. Check Ethernet

Setting
A) When the green block

3. Customize

Corel Workspace
A) In CorelDRAW, click

4.Test from

Ethernet
A) Put the Red

WATCH FOR THIS:

Laser Focus
Figure 1

With Lasers the
2.5 lens s
normal and
very clean. It
does Scan or
raster marking

|
2. LEARNED ABOUT FOcCuUs. ; o the ‘Tools’ Pull-Down
is on this item, push the i ositioning Light to the
Auto-F A) Go through the 3. SET UP THE ETHERNET CONNECTION. 'Enter" key. Menu and click [ Dosennd 9 and Vector
uto-rocus Main Boss Manual B) Push '2IU" kev t B) Now Click ‘Commands Top/Right cover of your
4. LOADED A TEST JOB ) Pus ey to and then choose from the material and hit the Y 1/4»
and look at the 5. CHECKED THE ETHERNET CONNECTION WITH THE move the changing item, little down Triangle the o~ lehanlriz e :
Pendant controls then push 'X+/-'keys and  Arrange’ command to see Origin’ key. A 1.5 lens is for

2. Check
Ethernet
Setting

3.Customize
Corel
Workspace

for the Laser.

B) Focus is very
important, the
material must be
2.5” from material if
the Focus Lens is
2.5”. Jog the Red
Position Light and
Plunger over the
material and hit the
Z/U button and
arrow down to

TeST JOBS

“Tip”
With a USB you are limited to
25ft and you will need a
repeater if the PC is not next

'Y+/-' keys to change the
value, when all the IP
values and the Gateway
values are changed,
push 'Enter’ key to
validate the change, or
'Esc’ key to invalidate the
change.

C) These Values come
from the Ethernet Card in
the PC. Go to the
‘Control Panel’ of
‘Windows’ and Network
setting , Local area
Connection and Details
to get the Ethernet

all the choices from that
Pull-Down, and Pull-out
with mouse the ‘Align and
Distribute’ & ‘Horizontal’ &
Vertical Page Positioning
to the page.

C) Now do the same for
‘Case Changes’ under the
‘Text' command into the
dialog, and click ‘OK’.
Lastly, place the ‘Case
Change’ on the Standard
Bar and the other icons on
the bottom of the TOOL-
Kit, and Click the ‘Tools’
Pull-Down and 'Save
setting as Defaults’ &

B) Recall the Test job in
Corel, Click the ‘File’
Pull-Down Menu and
‘Open’ and select the Job

and click 'OK’.
C) Click the LaserWorks

Full Power Cell Icon, and
put in the Power and
Speed and click
‘Download’. Now hit
‘Start’ on the Laser
Pendant and if the
download was ok you are

very small
marking and is
not for Vector
cutting. The 4.0
lens is for
vector cutting
up to one inch.
Sometimes you

Auto-Focus. to the Laser. If not use a Address to Plug in, within - Corelis set for a i need all three
AULO-FOCUS. - ; running from a Ethernet :
4. Test from C) Noyv thg Ethernet cable at 2500 ft }Siﬁ%": féﬁ;ﬁﬁ,‘gz_‘“e Workspace. or USB connection.
Ethernet material will come lengths. Figure 2 Figure 3 Figure 4

up to the Focus
Plunger and recoil
back to the Focus
length. Now start to
work yourself
through the Buttons
on the Laser
Pendant to become
knowledgeable of
their operations.

Laser Pendant

Key Steps to our Goal

Z/U Button: The Z/U key can be
pressed when the system is idle or

Laser Pendant

Speed: Set the speed of the current
running layer, or set the direction

keys move speed

Max. Power: Set the max laser

power of the current running layer, or

the work is finished. On pressing this
key, it will show some entries in the

interface, each entry includes some

functions, Z axes move, U axes
move, each axes to go home etc.;

Look heavily at
‘FILE’ and recalling
jobs sent.

set the power of “Pulse” Key;

Star/Pause: Start or Pause
a Job Downloaded to the Laser

Up/ Down Arrow Keys: To move
the Table Platform up and Down to
focus to the Material.

Min. Power: Set the min laser power
of the current running layer,

LaserBeam Beam File Accept
Fire Power Storage

Esc: To stop work, or to exit to some
menu.

Figure 1 Figure 2

N
@)« Video: A6-9




RDWorks Training

Figure 4 .
Figure 3 FoneE e —— s @ ﬂg o ‘* 3‘*‘)"
Major _ Creating Jobs ey | WATCH FOR THIS:
CheckPoints 3 Engravelab|oaa toa e

B = - Flame ups

for EngravelLab -
igure

Plale S,VeBOSS Laser Power&Speed | e

EngravelLab

to RDWorks

1. Five Steps

2. Power Cell

3.Color
Setting

4. Download

N
)¢

Video: B2

Using Power Cell

within EngraveLab

e 440

SHEE W R E A

_,v

s e

3

@ox_

Training Data Covered Here:
. CREATED A JOB IN ENGRAVELAB

1. Five Steps

A) As with any
software the Five
Steps to creating a
job apply. Size of
Plate. Text on the
Screen. Change
Fonts. Resize &
Position.

B)In EngravelLab
click on the ‘Plate
Size' icon, then the
Capital’ A’ on the
Tool-Kit and click
first ‘A’ for frame
text and type your
text on the page.
C) Now highlight
the line of text and
on the Smart-Bar
change the font
and resize. The
Frame will auto-

. LOADED AN ENGRAVELAB TEST JOB

a NN -—

“Tip”

correct Statement.

o Pendant Display
positioning and the Gragh dieple ’—‘_\R
job is now { SN

complete. Just
save the job under

the ‘File’ Pull-Down
Menu and we are \
done.

Running
progress bar b

dle 00.00.00 Count: 99X : 1805 mm Y: 2356 mm connect

/
Running A:i Working
Status Nugher

T o
File dimension Net Status

. LEARNED ABOUT COLOR ASSIGNMENTS.
. SET UP POWER AND SPEED PER CUT/SCAN.

. LEARNED MORE ABOUT THE PENDANT AND
PowER CELLS SCREENS AND COMMANDS.

First golden rule of Graphics
is, nothing happens unless
you something is selected or
highlighted on a line, is a 90%

Figure 1

Figure 2

|__parameters

Figure 2

EngravelLab to RDWorks

2.Power Cell

A) Click on the Power
Cell icon and the
Power Cell will open
up SO you can assign
changes to the
download parameters
B) First, look at the
color that registers on
the Dialog, or assign
your own colors from
the Color Pallet in the
Power Cell.

C) Now double click
on the main color,
verify you are, in this
case, in Scan mode
and put in 30%
Power for Max/Min.
Verify that your
interval is.007. Next
do the same for the
Cut Color.

3. Color Setting

A) In Engravelab or
CorelDRAW, your
color Pallet should
be in RGB not
CMYK to insure the
Power Cell will see
those colors.

B) As we said before
you can use the
different colors to
assign different
modes and effects to
the material.

C) This can even be
done within a line of
text and section of a
logo. Now click the
‘Download’ tab and
you will see the
layout appear on the
Pendant screen.

Figure 3

4. Download

A) Once the
download is
complete you can
press the ‘File’
button on the
Pendant and find
your last job by title.
B) You can even do
a Production-time
estimates or watch it
do the “Frame’ test.
C) Run the Auto-
Focus on the
material if needed
and once you hit the
‘Start’ button to run
the job. You can
Pause it or Cancel it
at anytime.

Figure 4

Key Steps to our Goal

Colors: This is how you separate

Main Interface

Speed: Whether for scan or for cut the
speed is how fast or slow the beam travels
through or across the material.

Max./Min Power: Usually the same value
and is a measure of the Percentage of Power

commands by assigning different
RGB colors to different selections on

your layout. You can assign different

applied to the material by the focused beam.

Pallet:

Interval: Is for the Scan feature and the

space between the lines

Process modes (Scan/Cut) or Power
and Speeds to those selections.

You even add items in the

Power Cell and change its color to
further control the download.

Process Mode: To where you cut or draw

also called vector or scan or raster across
the material turning the beam on where it

sees images pixels.

Learn First.

These are the Main Controls to

If you see a
Flame up on
the material
Check to see if
you have the
air pump on or
if you are
applying to
much power or
going to slow
into the
material for
cutting. If so

just lift the lid

and stop the
process. The
flame up will go
out.




Major
CheckPoints

RDWorks
First Job

1. Create a
One line Job

2. Color
Settings

3.Power &
Speed

4. Download

N
)¢

Video: B6

1. Create a one
line Job

A) Enter the
RDWorks
software from the
Icon on the
Desktop; Click
the ‘F’ icon on the
Tool-Bar and
click in the
middle of your
Work Pallet.

B) Next type out
MY Laser’; and
at the bottom of
the Dialog type-in
250 mm for size
and then select
your font.

C) Now click the
Rectangle tool
and draw a box
around the text.
Hit Ctrl-A to
Select All and
lastly on the
bottom of the
Tool-Bar is a
Centering Icon.
This will center
the two items -
the box and the
text in the middle
of the page.

Figure 1

Figure 3

Creating Your First

RDWorks Job

Making Our First Job in RDWorks

Training Data Covered Here:

| . CREATED A JOB IN LASERWORKS

“Ti pu

. ASSIGNED PROCESSING VIA COLOR SETTING.

. PuT IN THE POWER AND SPEED PER
CuUT/ScCAN.

. DOWNLOADED THE JOB

5. FOCUSED AND FRAMED THE JOB THEN RAN IT.

LaserWorks is a Graphical
Interface used to deliver the
layout to the Laser. It is Not a
Graphics Package, but can be
used that way if you wish.

Figure 2

|+ iCentering

Icon

Figure 2

|\| nu bar |

[ stemvar |

‘ Align bar ‘

o

Graphies bar
dit ban

Control panel

RDWorks Tralnlng

= | Color Pallet

RDWorks First Job

2.Color Settings
A) Click on the
Pick Tool at the top
of the Tool-Bar and
select the Text.

B) Now click on
your Color Pallet in
RDWorks, Select
the Black.

C) Next click on the
Box, and color it
Red. This allows us
to assign different
processes, like
Power & Speed or
Scan or Cut to
those selections as
identified by the
colors assigned to
it.

3. Power & Speed
A) In your Control
Panel you should
see Red and Black,
put the Black at the
Top & the Red
underneath it.

B) Black should be
assigned to Scan
and Red to Cut.

C) Double click on
the Color and
assign the Process
and Power at 25%
for scan Black and
600 on speed, and
on Red 30% Power
and 100 on Speed.
On Scan make sure
the Interval is .07
and you are ready
to go.
Figure 3

4. Download

A) Click the
Download tab at the
Bottom of the Control
Panel in LaserWorks.
B) Make sure you put
the position red diode
light over the material
and hit the Z/U button
on the Laser Pendant.
Arrow down to Auto
Focus and hit the
‘Enter’ button to
Focus.

C) Run the ‘Frame’
Button to insure you
are aligned to the
material; then hit the
‘Start’ button to run the
job. You can Pause or
Cancel it at anytime.

Figure 4

Key Steps to our Goal

Alignment Bar: Used to position

Program Layout
Menu Bar:

System Bar: This is the high use
commands and shows a list of icons

for ease of use..

Graphics Bar: Allows you to draw
quick shapes on the page like the
Rectangles, used heavily for

positioning.

This is simply the Pull-
Down Menus like ‘File’ etc..

objects on the screen to one another.

Layer Bar: |Is where you adjust
colors and settings for processing.

Control Panel: Used for setting
values to objects for processing.

Edit Bar: This Bar allows you to apply
changes and modifications to objects
and text already on the screen.

WATCH FOR THIS:

Page Settings
Figure 1

[Page width]:
Software page
width, usually
associated with
machine X breadth.
[Page height]:
Software page
height, usually
associated with
machine Y breadth.
Once connected to
the motherboard,
the software will
automatically
format the page size
for the current
operation. However,
if the motherboard
is not connected or
if a custom page size
is needed (as for
adjusting page size
to material), the
user can use the
page setting to
reconfigure the
page size as follows:
[Grid] Enables and
sets grid space.
[Keyboard] The user
can use arrow keys
to move or rotate
selected graphics.
[Color Config] Sets
the color of the
work area.




Major
CheckPoints

RDWorks
Power Cell |
1. Dialog

Overview

2. Scan Power
& Speed

3 Cut. Power
& Speed

4. Front-line
Features |

N
@)« Video: B7

oo |

Figure 3

1. Dialog
Overview

A) The LaserWorks
Power Cell within
Corel, AutoCad, or
EngravelLab has
one purpose; to
deliver the
Machining or the
Laser Parameters
to laser for the
graphic in question.
B) The Colors in
the RGB Pallet of
Corel or
EngravelLab should
match those in the
Full Power Cell.

C) You also can
save Material
Parameters for
Power and Speed
and Scan and Cut.
This is the most
important feature of
the Full Power Cell.

Figure 1

The Power is in the Cell

Training Data Covered Here;
. REviEWED RDWORKS POwWER CELL.
. REVIEWED SCAN PROCESS
. REVIEWED CUT PROCESS.
. CONTROLLED SCAN DIRECTION
. SHOWED THE UDISK JUMP DRIVE FEATURE.

a NN -

“Tip”
The RDWorks Power Cell
within Corel or EngravelLab has
one purpose. To deliver the
Machining or Laser Parameters
to the laser for the graphic in
question...

Power Cell Revisited

Figure 2

RDWorks Power Cell |

2.Scan Power &
Speed

A) Click on the Pick
Tool at the top of the
Tool-Bar and select
the Text Tool.

B) Now click on your
Color Pallet in
LaserWorks and select
the Black, if not
already assigned.

C) Double click on the
Color and assign the
Process and Power at
25% for Scan Black
and 700 on speed. On
Scan, make sure the
Interval is .07 and you
are ready to go. You
can click the Library
tab and assign the
Parameters to be
recalled later, this is
very important.

3. Cut Power &
Speed

A) Double click on the
Red color and Click
on the Process Mode
and choose ‘Cut’.

B) Red should be
assigned to Cut and
Black to Scan, if not
already assigned.

C) Double click on the
Color and assign the
Process and Power at
Red 30% Power and
50 on Speed. You
can click the Library
tab and assign the
Parameters to be
recalled later, this is
very important. For
both make the Max
and Min. Powers the
same.

Figure 3

4. Front-line
Features |

A) You can Control the
Direction of Scan or
Raster, | like the
‘Bottom up’.

B) You do the same for
Cut, you can also
select items within the
Preview screen to the
right.

C) Save to the Udisk to
transfer files via Jump
drives. Click ‘File’ on
the Laser Pendant,
arrow over to ‘Udisk’
and “Read it.’ Then
‘Copy File to Memory.’
You can then pick up
the job File and you will
see it in the Preview.

Figure 4

Key Steps to our Goal

Main Task: Laser Pendant

RESET: Datum or Reset whole

Laser System
Origin:
Point to the Laser Layout

Pulse:
Beam to the Material

Set Relative Starting

Pulse or Fire the Laser

File: Pick up File Download to the
Laser or Udisk

Star/Pause: Start or Pause a Job

Downloaded to the Laser

Left / Right Arrow Keys: JOG
the Lens around the Table via the

Figure 2

Frame:  Track around the outside
of the Layout

Motion System.

Up/ Down Arrow Keys: To move
the Table Platform up and Down to
focus to the Material.

WATCH FOR THIS:
Macro Upset
Figure 1

If the toolbar does
not appear, reinstall
the software
CorelDraw.

In the "macro
location" select
"<All Standard
Projects".And the
"Macro name"
choose the
RDWorksV8.Userln
it. (or
RDWorksV8.Userln
it)Note: Choose
your .Userlnit by
your version! And
then "Run".

Then go to Tools >
Macros > Run
Macro...




Major
CheckPoints

RDWorks
Power Cell Il

1. Front-line
Features I

2. Position &
Origin

3. Rotary
Device

4. Laser
Pendant I

N
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Video: B8

Figure 3
Export | Ganeral | Machine | Document | Manual | Info | Config C
=3 Power Cell
| Original or edit path [[] Enable rotate engrave = ]
oo, - = | Revisited Il
/] Auto determine start point and dir
| Auto find start point Circle pulse:
| Backlash reapy optime
Block handle Help
Height: 50 Dr: Bottomto v H
_ e More Power in the Cell
Line/cokumn setup Bottom to up
Lefttoright |
XNum: 1 Xspac|Right to left Position: | Current positior v
¥ Num:| 1 Yspace{mm): 0 [] Output select graphics
Bestrewing breadth... E
1. Front-line Training Data Covered Here:
Features Il . REVIEWED FEATURES OF THE POWER CELL.

A) There are many
extra features and
commands on the
bottom right tabs of
the Power Cell.

B) You can control
the direction of the
Scan or Raster, |
like the Bottom up
as the exhaust
flows from the top
and gives me a
cleaner look.

C) ‘Inside to
outside’ is a major
tool that allows me
to cut or vector the
inside first before
the outside keeping
the cut-out from
dropping out of
focus. This is also
why we scan or
raster before we
cut to maintain the
focus. The balance
of the commands
can be looked into
in the Mainlaser
Reference manual
online. These are
not high use items
for us at this point
in your training.

Figure 1

. REVIEWED THE ORIGIN & POSITIONING PROCESS
. INTRODUCED THE ROTARY DEVICE.
. REVISITED THE LASER PENDANT CONTROLS.

NN -

“Tip”
The LaserWorks Power Cell
can be used for 85% of the
Jobs you need to run. Some
Projects will require the Full
LaserWorks Graphical Interface
to Process.

-
= Current Position
- Ao Move
w= Offset(mm): | B
. Speedlmmjs); | 50
| Power(%): | 0
v+ 2+
- X |Home| X+ | Home
Y- z-

Export | General | Machie | Document | Manual | Info | Config

X=7
Y=7

z=7

Move from origin

IfLight

RDWorks Power Cell Il

2. Position &
Origin

A) Positioning of items
on the table is very
important to your ability
to produce product.

B) There is a Position
Table that can be
purchased or made
using the laser itself. the
pre-cut piece need to be
level and square, and in
the same place on the
Laser table every time..
C) Origin is simply the
starting point for the Job
based on the point the
RDWorks indicates. We
use Top/Right of the
image. Many times | put
a BLUE rectangle box
around the plate and tell
the Power Cell not to
output that color. Itis
there for positioning
control only.

Figure 2

3. Rotary Device
A) You can run a
Rotary Device for
360 degrees items,
performed with
Roller or Chuck
devices.

B) Use the LASER
Manual for this., but
*MAKE SURE THE
MACHINE IS
TURNED OFF
BEFORE
PROCEEDING*

C) The Origin point
and control will be
different; do not
attempt this until you
have dialed the
Laser in for the flat
material,then do the
more advance round.

Figure 3

4.Laser Pendant Il
A) If you press the
Z/U you will see an
internal menu that
gives you many
commands like
‘Auto-Focus’.

B) There are
controls for
‘Diagnostics’ and
the Pendant
appearances..

C) | Use this area
to setup the
Internet
connection for
more control over
the Laser and the
PC interface.

Figure 4

Key Steps to our Goal

Figure 2

Functions Buttons:
Start: Send the current graphic to
the machine for processing.

Pause\Continue: Ongoing
processing is halted when the
Pause\Continue button is clicked.

Clicking it again, causes a paused
operation to resume.

Stop: Clicking this process simply
stops the processing work.

Save To UFile: Clicking this button
saves the current file as an RD file
which can be used for offline
processing.

The file can be copied to another
memory board for full offline
operation. Use this option to export
your file(s) to a USB flash drive, then
to import into your machine.

UFile Output: Clicking this button
outputs the current file in RD format.
After saving a file offline, click Ufile
Output to select the RD file for
processing.

Download: Clicking this button
downloads the file to the memory of
the controller,

WATCH FOR THIS:
Scan Speeds
Figure 1

Recommended
Maximum Scan
Speed:
LS/HP-1416s =375
mm/s LS/HP-1630s
=400 mm/s
LS/HP-2436s = 500
mm/s LS/HP-3650s
= 600 mm/s
LS/HP-5298s & SS-
3650s = Speeds will
vary. Please contact
manufacturer for
details.




Major

CheckPoints

RDWorks
Download
Docker |

1. Laserworks
Download
Docker

2. Rotary
Device Il

3. Check
Auto-Focus

4 Intermediate
Features

< Video: B9

1. RDworks
Download Docker

A) Just like the
Power Cell the
Control Panel area
of RDWorks,
Download Docker
has a Work Section
to input your Power
& Speeds &
Processes.

B) You have the
‘Output’ Tab that
allows you to turn
on the ‘Rotary
Device’ and enable
Feeding.

C) The other main
area of the Control
Panel is the ‘User’
tab; if you slide to
the bottom of the
text commands you
will see ‘Focus
Depth’. This is
important when we
do an ‘Auto-Focus’;
the material will
return via the Z-
axis platform to the
focus length of the
lens or we will not
get a proper mark
or cut. This will be a
different amount for
each lens size
used.

Figure 1

Figure 3

Download Docker
Controls

Controlling input from
the Software to the Laser

Training Data Covered Here:

. REVIEWED THE MAIN TABS OF THE CONTROL PANEL
. REVIEWED THE ROTARY DEVICE PROCEDURE FOR

CHECK AND ROLLER.

THE LENS

THE CONTROL PANEL.

“Tip’
The Control Panel is
mainly used to input Power
and Speed parameters, but
there are many powerful

features hidden in it.

work Output Doc | User | Test | Transform I

/] Enable rotate engrave

Gircle pulse: | 1000 Help -

Tl 20 Tao TR RESTT

[ Enable Feedng Control Panel
Feeding Distance(mm):

[] Backlash reapy optim

|_| Enable offset of Laser2
X | ]

. CHECKED THE AUTO-FOCUS RETURN LENGTHS FOR

. TALKED ABOUT THE INTERMEDIATE FEATURES OF

Figure 2
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2.Rotary Device Il
A) Turn off the Laser, unplug
the Y-Axis drive cable from
back of the cabinet & plug in
the Rotary Device.

B) Now turn the machine on
and let the laser head return
to the home position. Since
you unplugged the Y-Axis
connector and replaced it
with the rotary attachment,
you'll notice that the laser
head will only go to the right
until it hits the X-Axis limit
switch. This is normal. After
the laser head has moved
all the way to the right, move
& push the gantry all the
way to the back of the
machine so that the Y-Axis
limit switch has been
triggered.

C) In the Control Panel go to
the ‘User’ Tab and click the
‘Rotary Device’ section. Now
put 35 in the Diameter under
‘Circle Pulse’ Check
changes for value, usually
6820.

3. Check Auto-

Focus

A) Jog the Red Positioning
Diode over the material
and hit the Z/U button on
the Pendant to raise and
lower the platform.

B) Using the Acrylic
Manual Focus tool, place
the short end over the
Plunger Bracket and adjust
the table to have the lower
larger end touch the
material.

C) Now on the Pendant
arrow down to the Auto-
Focus and hit Enter. The
table will rise to the Plunger
and retract back and
measure it with the Manual
Focus tool. If wrong on the
control panel go to the
‘User’ tab and slide down
to ‘Focus Depth’ and adjust
amount starting at 50.00
and write the new value to
the laser. Test Auto-Focus
and repeat until correct.

Figure 3

4. Intermediate
Features

A) There are many
features of the Control
Panel tabs, the majority
you do not touch.

B) Cal time:. The
number of hours
already spent in
applying a particular
file can be calculated
and displayed by
selecting the file and
then clicking the Cal
time button.

C) Estimator works
really well from the
Motherboard when a
laser is hooked up to
it.

Figure 4

Key Steps to our Goal

Control Panel Iltems:

Focus depth: Use this auto focus
operation to find the corresponding

panel.

Delay before feed: When using this
option and the feeding device, a brief
pause can be forced before each
feeding process begins. This pause

allows for any last-second

adjustments before processing.

Return position: The user can

select the location of the origin point

for the machine. This parameter
determines the precise point at whlchm-: special mode is to make the laser high

the laser head stops after completin)g»“ﬁpower short duration beams

each operation.

|

|

|
v

Cutting mode: The following three
cutting modes — split precision, fast, and
ultra-fast —can be set as appropriate.
When accuracy is paramount, the user
should select the precision cutting; when
speed and production is most important,
the user should select ultra-fast cutting.
Scan mode: Two scanning modes are
available, general and special. The
general mode does not allow treatment
during the scan, while the special mode
allows treatment of light spots. If the
special mode is activated, the power of
the laser will be increased in such a way
as to reduce the proportions of light
spots. The purpose of selecting the

WATCH FOR THIS:

Scan Speeds
Figure 1

The minimum and
maximum power
should be set to the
same values for a
synchronous
adjustment
(consistent). If
Default box is
checked, the Min. &
Max. power set on
the Control Panel on
your machine will
be the power at
which the file is ran.
* There is Also a
Parameter Library
for Saving the
Power Speed for the
Process you are
using...
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CheckPoints

RDWorks
Basics
1. Screen

Layout

2. File &
Standard Bars

3. Positioning
Bar

4 ToolKit
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1. Screen Layout

A) When learning
the Screen Layout;
not only memorize
the position and
function of the
Bars and Icons,
But learn how they
work together.

B) Laser
engraving is based
on computer
controlled machine
tools that allows
the user to achieve
effective control of
a wide variety of
processing tasks.
LaserWorks is a
cutting edge
example of a
computer
controlled
Graphical
Interface.

C)The
components of the
RDWorks system
includes a
controller card, a
control panel, and
supporting
software.

Figure 1

Figure 3

Tools and Their
Position

Learn Your Graphical Interface
Locations

Training Data Covered Here:
| . REVIEWED THE MAJOR SECTIONS OF THE
SCREEN LAYouT
. REVIEWED THE ICONS OF THE FILE &
STANDARD BARS
3. REVIEWED THE ICONS OF THE
POSITIONING BAR
4. TALKED ABOUT THE FUNCTIONS OF
THE TOOLKIT.

n

“Tip”
Learn the Location and title of

the major areas of LaserWorks.
It really helps if you need to talk

to customer support.
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RDWorks Basics

2.File & Standard

Bars

A) With the File and
Standard Menus and
System Bars you can get
to all the major
commands.

B) Let’s start with ‘Import’
commands and the
‘Simulate’ engraving
commands.

C) To import a file, follow
the procedure below.
Click menu [File] >
[Import], or click the
icon, Then select a file
and click open or preview
to see a particular file.
For most vector files, the
LaserWORKS software
will automatically import
the file into the
corresponding layers of
LaserWorks according to
the layer description.

Figure 2

3. Positioning Bar
A) Positioning Bar
which is the Alignment
Bar is just for that.

B) To Align objects on
the screen to each
other in a quick and
easy way.

C) | would put two or
three lines of text and
Rectangle on the
screen and move
them around at will.
To discover the ones
you like the best, here
are a few of my
favorite commands.
Commands:
Left/Right Top/Bottom
& Align center to
middle and those that
control spacing.

Figure 3

4. ToolKit

A) Toolkit or Edit Bar is all
about drawing graphics

B) Lines: To draw lines,
click the Edit Bar , and
drag the mouse on the
screen to draw the desired
line. Press the “Ctrl’key for
horizontal or vertical lines
Polgon/Polylines: click
the Edit Bar and drag the
mouse across screen to

draw the desired polyline.
C) Rectangles: click the
Edit Bar icon & drag the
mouse on the screen to
draw the sides . Press the
“Ctrl” for a box.
Ellipses: Drag the mouse
on the screen for ellipse.
“Ctrl” key for a circle.

Figure 4

Key Steps to our Goal

Edit Bar: Also called the ToolKit
allows you a series of commands i
that allows quick changes to the

LaserWorks Screen

Positioning

Menu BAR: Allows you Access to
Majority of the Commands via the

Pull-Down Menus

System Bar: Also Called the

object.

Layer BAR: The Color Pallet that

allow the assignment of Color to
individual object to assign a process

to them.

Standard Bar in most Programs gives
access to high use commands.

Graphics BAR: Also Known as the
Property as it change with jobs and
gives you control over size and

dimensions of objects.

Alignment Bar: Does just that alig

Control Panel: Gives a place to
assign power and speed to the
different processes.

WATCH FOR THIS:
Page Size
Figure 1

To control page
setting , click [Menu]
[Config] > [Page
setting].

[Page width]:
Software page width,
usually associated
with machine X
breadth.

[Page height]:
Software page
height, usually
associated with
machine Y breadth.
Once connected to
the motherboard, the
software will
automatically format
the page size for the

current operation.
However, if the
motherboard is not

connected or if a
custom page size is
needed

(as for adjusting page
size to material), the
user can use the page
setting to reconfigure
the page

size as follows:
[Grid] Enables and
sets grid space.
[Keyboard] The user
can use arrow keys to
move or rotate
selected graphics.
[Color Config] Sets
the color of the work
area.




Figure 3

Text

Major
CheckPoints

RDWorks
ToolKit |
1. Pick Tool

2. Adding Text
Dialog Box

ey =

Map a0

—

Toolkit Functions of

the EDIT Bar

one tool at a time!

1. Pick Tool

A) The Pick tool
lets you select,
size, skew, and
rotate objects.

| . REVIEWED THE PICK TOOL OR SELECTION TOOL.

Training Data Covered Here:

2. TALKED ABOUT ADDING TEXT ONCE IN
RDWORKS.
3. TALKED ABOUT SCANNING

4. TALKED ABOUT QUICK POSITIONING WITHIN THE

We begin to Learn the Program

®TeTyoefont: | T Tahoma
SH fort: B Fe.gr

BOSS Laser
An American Company

RDWorks ToolKit |

2. Adding Text

Dialog Box

A) With a Graphical
interface add different text
to the screen.

B) Just select the ‘Text tool’
and click in the middle of

ki wdth: | 50 »
Char spaces |9 mn

Line space: |9 mn

Enable variabie text

3. Scanner/Capture
A) On the Tool-kit or Edit

Bar is the ‘Capture’ Icon;

this is there to scan
images into the screen
Pallet of LaserWorks.
B) If the computer has

4.Positioning

A) There are many ways to
position in LaserWorks; the
most important is ‘Center
Data’ this puts your
grouped item into the center

WATCH FOR THIS:
Defaults
Figure 1

To control page
setting , click [Menu]
[Config] > [Page
setting]. When this is
done, the following
dialog box appears
2):[Page width]:
Software page width,
usually associated
with machine X
breadth.

[Page height]:

i the screen. a Text dialog o - N
3 S & B) NOthIng SCREEN PALLET. box will appear and then _been conn_ected to t_he of the ‘Screen Pallet'. SO.ttVVal(. page
-ocanner happens unless you type. You can size and 't;“age_I?eVlce, th'le'hqlalog B) The Horizontal and height, usually
mething is Kern, even change fonts to ox will appear. This . . . associated with
Ca ture SO s TrueTh d SINGLE - : Vertical mirror icons on the < .
P selected is a 1 ype an dialog box enables the machine Y breadth.

4 .Positioning

Video: B9

Golden Rule of
Graphics Art, and
applies 95% of the
time.

C) Before you can
change an object,
you must select it.
You can select
visible objects,
objects that are
hidden from view

“Tip” .
Nothing happens unless

you have something

line engraving fonts.

C) Enabling variable text
reveals two variable
functions: Date and Serial
Number. Each function has
its own properties and
formats. For example, the
date variable text supports
12 & 24 Hr formats &
different mm/dd/yy. It can
also be updated
automatically from what
your PC is set to. Just be
sure that the format is the
same for both cases.

user to import pictures
from a specified device.

C) Under the ‘Config’ Pull-
Down Menu is ‘File Para’
Setting. This will bring up

the ‘File Parameters’
Dialog screen. In there

you will see the ‘DXF unit’

to right, select the down
arrow and click on
inches; This will ensure
proper scaling in Inches
to Metric conversions.

toolkit will reserve the
position of items selected
and allow you to do
reversed upside down
engraving.

C) Remember there are
many position keys but
the position of the layout
on the Screen pallet does
not matter - only the
origin point, Origin top-

Once connected to
the motherboard, the
software will
automatically format
the page size for the
current operation.
However, if the
motherboard is not
connected or if a
custom page size is
needed

: . right. (as for adjusting page
. . . S (=4
by othe!' ObJeCtS-’ selected is a Golden Rule Figure 2 Figure 3 Figure 4 size to material), the
and a single object .
in a group or a yar: user can use the page
- setting to reconfigure
WA ] Key Steps to our Goal
addition, you can P o’ P Mirror: This button reverses fi :
) ; q= - ¥ : ollows:
select objects in I g ‘lk E: Toolkit ICONS horizontal and vertical objects for [Grid] Enables and
the order in which —|E P - 5 Text: To add text, take the following selected images or text. sets grid space.
they were | I steps: Click [Menu][Draw] > [Text], or Kevboard] The user
i _ = ; ; ; ; Center Data: Put all data to the [Keyboard] The user
Cre_ated, select all B o] i f;'ftkifﬂg tﬁgltrssaljnli?%nbggi:)htee':({nsert center or middle of the Work Pallet, can use arrow keys to
objects at once, & E o- e s but be sure you are grouped first. move or rotate
and deselect L selected graphics
|l Text . q S graphnics.
; = S To i ; Work Pallet: This is the grid screen \
objects. S = Capture: To import a stored object, . . ’ Color config] Sets
J I gcen & invoke Select Source box (below) by where the Laser will draw its t[he color of tﬂe ek
x| i clicking [Menu] [Draw] >[Capture]. If graphlcal information from; the !
< - the computer has been connected to position of your layout does not alee
dh g g the image device, the dialog box will matter in the Defaulted setting. Just
4| - o- appear. This dialog box enables the center it for easy viewing.
- = user to import pictures from a
. g " specified device.
Figure 1 |38 | Figure 2




Major
CheckPoints

RDWorks
ToolKit Il

1. Matrix Copy

2. Shapes &
Graphics
Tools

3.LGP
Functions

4 Node Edit
Tool

N
@)« Video: C11

Figure 3

More Toolkit
Functions

e
-

JEP AN

1.Matrix Copy

A) To duplicate
an object for an
array, first
Select the object
by clicking on it.
Then on the Edit
Bar, click the
‘MATRIX COPY’

B) The Array
dialog screen will
appear. A user
can replicate an
array in different
directions. The
direction of
copying is based
on the original
graphic. If the
user chooses
“lower right” as
an array
direction, the
original graphic
will appear in the
upper left corner.
C) Once the
Array is
processed,
Group the Layout
and Center to the
Work Pallet.

Figure 1

big for Production

Training Data Covered Here:

| . LEARNED TO COPY IN A ARRAY OR MATRIX

2. UseD THE QUICK SHAPES
3. TALKED ABOUT LGP DESIGN
4. TALKED ABOUT NODE EDITING

“Tip” .
Drawing Basic

Shapes quickly helps

complete jobs.

5 Laser BOSS Laser” BOSS Laser 9

Matrix or copy object is too

4

Shapes

2. Shapes &
Graphics Tools
A) The Ellipse
and Rectangle
tools can be used
to make borders
or cutouts.

B) The ‘Line
Tools’ are used to
join or create
underlines to
words or objects.
C) These quick
shape tools are
useful to add
Vector Cutout or
fill in to correct
errors in your
graphical layout.

Figure 2

Key Steps to our Goal

RDWorks ToolKit Il

3. LGP Functions

A) To activate the LGP
Design tool, click the
menu command [edit]
/[LGP design], or click
the drawing toolbar.

B) The software creates
standard rectangular and
oval outlines. Import a
graphic design; then by
clicking on text that you
put on the screen, you
can choose to have the
outline of the document.
It should be noted that
the outline file must be a
closed graphic, or the
system will automatically
delete it.

C) This Tool is very
Advanced and should
not be used without
advanced instruction.

Figure 3

4.Node Edit Tool

A) A curve object has nodes
& control handles which you
use to change the shape. It

can be any shape.
B) An object’s nodes are

the small squares that
appear along the object’s
outline. The line between
two nodes is called a
segment. Segments can be
curved or straight. Each
node has a control handle
for each curved segment
connected to it. Control
handles adjust the curve of
a segment. Components:
control handles, segments,
& nodes

C) Once clicked on node
edit a menu allowing you to

edit..
Figure 4
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Figure 2

Shapes ICONS:

Lines: Click [Menu][Draw] > [Line],or
click the Edit Bar , & drag the mouse
on the screen to draw the desired line.
Press the “Ctrl” key while dragging the
mouse for horizontal/ vertical.

Polgon/Polylines: Click
[Menu][Draw] >[Polgon], or click the
Edit Bar the and drag the mouse
across screen to draw the desired
polyline.

Rectangles: Click [Menu][Draw] >
[Rectanglel], or click the Edit Bar icon
& drag the mouse on the screen to
draw the sides of the desired

rectangle. Press the “Ctrl” key while ‘s ’ X o
dragging the mouse to draw a squar?.’—\semng- Just center it for easy viewing.

Ellipses: Click [Menu][Draw] >
[Ellipse] or click the Edit Bar icon, and
drag the mouse on the screen to draw
the desired ellipse. Press the “Ctrl” key
to draw a circle.

Point: Click [Menu][Draw] > [Ellipse],
or click the Edit Bar icon. A point can
also be drawn simply by clicking the
mouse on the screen. Work Pallet:
This is the grid screen, where the
Laser will draw its graphical
information form; the position of your
layout does not matter in the Defaulted

WATCH FOR THIS:
Nodes

Figure 1

Curve objects created
in Laserworks
follows a path that
gives them their
defining shape. A
path can be open

or closed and can
sometimes include
subpaths.

For more information
about paths and
subpaths, see
"Breaking the path of
curve objects."

Most objects that are
added to a drawing
are not curve objects,
with the exception of
spirals, freehand
lines, and Bézier
lines. Therefore, if
you want to
customize the shape
of an object or text
object, it is
recommended that
you convert it to a
curve object.




RDWorks Training

Figure 4 .
Figure 3 .
Major | L. % (445,91 | pm W (235,989 | ey | (100 | =, B ﬂ
CheckPoint o RDWorks POSItlonIng Y |zea.z08 mm F (208,549 mm| (100 | e WATCH FOR THIS:
in e o . . -
LNeckroints e Bar | Toolkit Functions Origins
N —— O 0 Y Process NO: |1 Figure 1
RDWorks i Bl o Y[ e s o
Positioning Quick Sizing and Positioning @ e et
Bar | : are key Features of Laserworks view of an object by
= . m . the way it is placed
RDWorks Positioning Bar | relative to the origin.
LaserWORKS v8
provides the
1. Sizing 1.Sizing Training Data Covered Here: 2.Origins 3. Positioning 4.Rotation and following tools to
. . LEARNED TO SIZE ITEMS ON THE WORK PALLET A) The origin is the point A) Position can mean Process control the placement
A) The size of the . USED ORIGINS on a Laser where the many things, the position A) You can Rotate of an object:

2. Origins

3.Positioning

4 Rotation and
Process

Video: C12

layout or individual
object is shown on
the Standard Bar
and will indicate
what is selected
and what can be
adjusted by that
selected process.
B) The sizing of
the Layout and
individual line and
object is
determined in the
design software.
C) Transformation
refers to a change
in the location,
orientation or size
of an object.

The object
transformation
menu provides a
convenient
interface for users
wishing to change
the location,
orientation or size
of a selected
object. The user
can mirror and
rotate an object
within the draw
toolbar.

NN -

. TALKED ABOUT POSITIONING
. TALKED ABOUT ROTATION & PROCESS

“Tip” .
Quick Position is the key to
controlling any graphics

Software.

Work | Output | Doc | User | Test | Transform

<] et i =7

Figure 2

lasering will start. Its
usually set to the top/right
of the plate.

B) You jog the RED
Positioning Light to the
top/right corner of the
plate or jig you are using .
Now press the Origin
button on the Laser
Pendant and as long as
the software origin point is
the same you will run from
that point.

C) Under the ‘Config’ Pull-
Down Menu is System
Settings’ you can change
the software origin point
there. The user can select
the location of the origin
point for the machine. This
parameter determines the
precise point at which the
laser head stops after
completing each
operation.

of objects on the screen to
one another or the
position of the laser beam
to the part you are
engraving.

B) The position function is
used to return the laser
head to a predetermined
location after processing
has been completed.
Possible return positions
include the current
position, the last position
that was anchored, or to
the position that has been
set as the “machine zero”
position.

C) Learn the Position that
affects the layout
downloaded first, then
learn the position of the
selected objects to one
another.

Figure 3

objects on the screen or
Work pallet as you see fit
in the ‘Transformation’
Docker of the Control
Panel.

B) You can turn on the
Rotary Device and do
360 degree engraving as
we have talked about
earlier.

C) To process is simply
to click the Download tab
in the Control Panel and
send the job to the laser
Que for processing.
Where you can select
the job from the Pendant
‘File’ Button anytime.

Figure 4

Key Steps to our Goal

Positioning ICO

Position:
Horizontal(H) | 300 mm

Vertical(v) = 500 mm

[ relative position

Oo-0-1
O ® O Apply to copy
O-0-3a Apply

Figure 2

Flowe ! 127509 op &) &2 @ -« =3 [0 B

The precise alignment of objects
can be determined by making use
of the tools provided by the
Alignment Bar:

SEXRNWED Hx=08
The specific functions invoked by the
icons on the Alignment Bar include
the following:

A: From left to right, these icons
cause right alignment, left alignment,
bottom alignment, and Top Alignment.

2 S0 oo

From left to right, these icons cause
vertical center alignment, horizontal
center alignment, & center alignment.

s LA

Ly =
From left to right, these icons cause
an object to be placed at a
horizontally equidistant point
or at a vertically equidistant point.

From left to right, these icons cause
objects to have the same width, the
same height, or the same size.

* Clicking the icon
results in the
placement of the
object in the center
of the page, such that
the center of the page
and the center of the
object overlap.

* The use of the icons

cause the selected
object to be placed in
one of the upper or
lower corners.




Figure 3

RDWorks Training

Figure 4
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i T indle(W) View(\V] Help(H) Model(M)
gllhaj okrp - e - RDWorks System Bar WATCH FOR THIS:
eckKroints i X parr | Bt ™ . =, . .
Al S Functions @,3% G-}% G]% B, @% Qﬁ Cut in/ Cut Out
[]5mal circle speed imit [ ScamingReverse interval Figure 1
RDWorks C—— Auto | CutInfout| Check || Draw
Standard Bar | o e Z©©mmg and Cut In/Out ] [I_[H 300 [q 200 [q 100 [H To make cut in/cut
< L > are Hug@ f@@th@S out 11n‘e.s, the user
must first enable the
RDWorks Standard Bar | cut-in/eut out
1. Admin function. There are
: B two types of the cut
Functions 1. Admin Training Data Covered Here; 2.Zoom & Show 3.Edit Cut In and 4.Edit Cut in/cut out lines:
Functions . LEARNED ADMIN SETTING Path Tools Out Parameters straight lines and

2. Zoom &
Show Path
Tools

3.Edit Cut In
and Out

4 Edit Cut

A) As stated before
the Admin Function
of LaserWorks is
controlled by the
Factory and should
not be changed
without instruction
from the factory.

B) System
Settings is the
important one and
you verify X-&Y

. Usep THE ZOOM TooLs FOR VIEW

. TALKED ABOUT CUT IN & CuT OuT

. TALKED MORE ABOUT THE EDIT BAR HIGH
TOOLS.

A) Zoom in and out of a
graphical Layout can
show any errors and are
easily corrected.

B) ‘Show Page’ ZOOM
is the one | use the most
to reveal all that is on the
Work Pallet. Remember,
you cannot fix it if you do
not know it is broken.

C) Show path: By
checking the “Show
Path” button at the
bottom right of the
cutting properties dialog
box, the user can see
the current graphics

A) The Cut in & Cut out
Menu Bar can be
activated for your ‘View’
Pull-Down menu.

B) It will allow the laser
to start to cut from
outside or inside the
object to be cut.

C) You can control the
Angle and length of the
cut from the ‘Cut In/Out’
tab; so it will start from
the outside of the cut and
end from the outside.

If you were cutting circles

A) Of the Tools on the

Edit bar or Toolkit the
rectangle is used the most.
If you hold the ‘Shift and/or
Ctrl’ modifier Keys down
you draw a perfect centered
box.

B) Using the Matrix or Array
Tool. Once | have set up an
Array then | hit Ctrl-A to
Select All and click the
Group icon then center to
the Work Pallet.

arcs. Straight line
cut-ins are created in
threeways:

* By cutting in at an
angle. In this
procedure the cut in
line and starting
segment form a
specified angle (in
which
counterclockwise
angles are positive);
* By cutting in at the
center, and by

M,gr%;FCh?Cked Tip" cutting order and the Svrz)j Ig (;rt];rr(t)ltr?: r::ilt Ion the ©) Then use the Text tool making the starting
Parameters an 'S0 outting direction. This will > : that add test information - N8
Inches. You have to Zoom in and Zoom help you control when inside of the circle and point of the cut-in

C) Once connected

to the motherboard,

the software will
automatically
format the page
size for the

current operation.
However, if the
motherboard is not
connected or if a
custom page size

out of a graphic to really see

what is there.

and where something
engraves on the
material.

Figure 2

end there. Thus getting
a very clean edge all
around the circles edge.

Figure 3

or change to a true Single
Font by clicking SHX
font, there are about 25 of
them.

Figure 4

Key Steps to our Goal

You can select a portion of an existing

ZOOM ICONS:

To move an object, click [Menu][Edit]
> [Move}, or click the icon. Then, with
the cursor in the drawing area, keep

object and magnify it to fit within the
existing drawing area by using the [View
Select] function. To do this, enter
[Menu][Edit] > [View Select], or click the

is needed_ . I g:,z Ieﬂaw?#(:?nl:aeyed:pressed eld icon. Then move the cursor to the drawing
(as for adjusting . Sl il Menu] (Edi] > area, and then drag the mouse while
page size to ‘ Zoom Out, or click the icon. Then, holding the left button down. A dashed

material), the user
can use the page
setting to
reconfigure the

Edit Bar

each time Bhe mouse is clicked while

the cursor is in the drawing area, the
drawing area zooms out.
* To zoom in, click [Menu] [edit] >

Zoom In, or click the icon. Then, each

border appears. When the left button is
released, the portion of the image that
had been enclosed by the dashed border
fill up the drawing area. @You can display
the page frame fully by either entering

line at the center; and
* By cutting in at the
center, drawing the
cut-in line from the
center to the starting
point, and by
assigning it a specific
length.

ke orieie e [Menu][Edit] > [View Page Framel, or by
clicking on the icon. BBelected data
objects can be completely displayed by
either entering [Menu][Edit] > [View Data

f Frame] or by clicking the icon. B

time the mouse is left-clicked while
the cursor is inside the drawing area,
the image will be zoomed in. B

page.

Figure 1 Figure 2

Video: C13




RDWorks Traini
Figure 4 n

Cutting optimize handle | x| Setting close errar

-Figure3
. m°’“"°”¢¥“ Close error{mm): | 0.100
?;nhajokrp _ More RDWorks Systenmnr v=--= ! s WATCH FOR THIS:
S e S ol Bar Functions - | Cut Optimize

RDWorks
Standard Bar
|

Vectorization turns Bitmap
Logos to Lines

Start point optimize

Ok

] Auto determine start paint and direction

Cancel

Ole ¢ o~ w O & o =

B8 W mimsweg ¥ =

RDWorks Standard Bar Il

Figure 1

Before processing After
processing

Female Male

Laser head. zThe arc
length of the cut-in arc
is set by the user. As the

1. Smooth 1.Smooth Curve Training Data Covered Here; 2. BMP/ 3.Curve Auto-Close 4.Cut Optimize figure below shows,
| . LEARNED TO SMOOTH CURVES OF VECTOR Vectorization A) When using Scan or  a) cut Optimize controls there are two types of
Curve A) Smooth Qurve GRAPHICS A) The Bitmap Handle ﬁ:gt;z:s‘-’vti Ziiﬂ::?f&iy direction and order of Cut and cut in/cut out arc,
doeslone main ) 2. Usep THE BITMAP HANDLE TO ADJUST LOGOS AND function s_et§ such image 'Bi is important that we cut the female and male:
function and that is characteristics of bitmap are not Bitmaps, we use AR
PHOTOS images as size, this tool. inside of letters before we do Path optimization

2. BMP/
Vectorization

3.Curve
Auto-Close

4 .Cut

to remove
machining pixels
toward smoothing
the look or cut of
the graphic.

B) With your

3. TALKED ABOUT CLOSING CURVES
4. TALKED ABOUT OPTIMIZING THE CUT AND ORDER OF
ENGRAVING

resolution,

brightness, contrast, and
color. Click “Bitmap
handle” dialog box
(below),click the icon,
select a bitmap, and then
click [Menu][ Handle] >
[Bitmap handle].

B) To check closure,
invoke the “Setting close
error” dialog box by
clicking [Menu][Handle] >
[Curve auto close], or by
clicking the System Bar
icon. Using the “Close
error” define the distance

the outside of letters.

B) Path optimization relates
primarily to the re-ordering of
vector graphics. To begin the
path optimization process,
click [Menu][Handle] > [Cut

relates primarily to the
re-ordering of vector
graphics. To begin the
path optimization
process, click
[Menu][Handle] > [Cut

object on the Work
Pallet, select a
single section and
click the ‘Smooth

B) This process will prep
a Logo or Photo to be
lasered.

C) Many times with
Photos we use

in millimeters from starting
to ending point. When the
distance is less than this
“Close error” tolerance, the
curve is closed

optimize], or click the

optimize], or click the icon. )
the icon. These

Use “Cutting optimize

keystrokes “Cutting
optimize handle” dialog

handle” dialog box, To view
the cutting path before and

Curve’ icon on the “Tip” EngraveLab BOSS | . o box, To view the
. b automatically. The “Force after processing, click " -
Optimize Standard bar, and ' _ Eﬂ&oqu.ﬁ sp :j%c: es ivith to close” box forces the [Menu][Edit] > [Show Path], or :lflttet:ngr g:;l;liagtortieand
select the Custom Doing photos will many Photo Laser PLUS, this closing of all selected sk the icon. atte 1? ld;l'gf(
tab. generator will dither the g'-;”{re'? s important with | €) Production output and user Sloud clic o
; ; ; Photo so it appears clear IS IS Important wi Menu][Edit] > [Show
C) Now adJ.USt the times require you to on Materials F;F;peda”y Vectors or Cuts as well as  Quality is the key reason for E’ath] 3)[1. CliC]k th[e icon
look and click wood and plastic. for a smooth cut. > :

Video: C14

‘Apply’ then ‘OK'.
Next select another

Purchase EngravelLab

part of the Graphic, — = K E; t ( ; I
repeat until you are o - ey epS O OU r Oa
done. | usually do (i s : _

S LT == H . ave as]. This button retains the
this in EngravelLab L e = Bitma - Handle. PI'OCQSS. results of the previous operation,
or Corel, but it — i Apply to view]. Until this button is allowing a processed image to be

’ = clicked, the most recent changes are exported/saved to the hard drive
works very well only previewed without affecting the :
here, and | cleaned gmin original bitmap. [Apply to view] button G :

) ot ’ ray scale]. Because most images
up the item fast Fi Ungamentafs o itz azeh GllEhet), ite ICames] uiien & need to be in gray scale, this function
here. as well ; T Itsiéeron gt Gir Uiio Gltelleg) o @ (22 is often applied as the initial step in a

’ ’ 0 rEI D A i [prEsEl i e (@ e @ilgl Tl iz multi-step transformation of colored

. ARANLIAA ALUTE, sratE thus, this option is good for trial-and- images. After the gray scaling has
== St fpremae. error adjustments. . . . been done, the user should click the
i = — * [Apply to source]. With this setting, [Apply to source] button. It is
== e changes are made directly to the source important to remember fhat gray
image, and pressing [Cancel] will not scale requires less memory than a
restore an altered image. Therefore this colored image, so it is especially
option is mainly used in a multi-step useful to gray ’scale large images as
Fiqure 1 T — operation, such as transforming general the first step in a processing
g == Figure 2 [t i g sesl. sequence to avoid memory problems.

Figure 2 Figure 3

this feature of LaserWorks. The graphics cutting
path always starts from
the laser head.

Figure 4




Major
CheckPoints

RDWorks
Standard Bar
]|

1. Combine
Curve/Delete
Overlap

2. Offset
Polygon

3.Check
Data/Preview

4.Group/
UnGroup

N
@)« Video: C15

Setting combine error

Combine error{mm}:

. Figure 3
= Finishing up on
RDWorks System Bar
Features

Logo Control of Graphics

1.Combine
Curve/Delete
Overlap

A) ltis difficult to
Vector or Cut lines
or shapes if they
are NOT closed, it
is also important for
quality of a scan or
rastered image.

B) To combine or
merge curves, use
“Setting combine
error” dialog box
by clicking
[Menu][Handle] >
[Combine Curve],
or clicking the icon.
The software
automatically
merges selected
curves when the
merge tolerance is
less than the value
set in the “Combine
error” box in
millimeters.

C) Once you use
the Shape tool or
Node Edit tool to
move the point of
the ends together
then activate the
tool.

Figure 1

Training Data Covered Here:
| . LEARNED TO COMBINE AND DELETE CURVES
AND OVERLAPS

RDWorks Tralnlng

[¥] Chedk dose
|¥] Auto dose

[¥] Check self-cross
(V] Check cross

V] Check overlap
[]Enable error

Data check

RDWorks

Error(mm): | 0.01

L

No selected curves for check!

Error(mm): 0.01

RDWorks Standard Bar IlI

2.0ffset Polygon
A) Main use for ‘Offset
Polygon’ is to either

create additional lines

2. Usebp OFFSET POLYGON TO CREATE LINE
THICKNESS

3. TALKED ABOUT CHECK DATA AND PREVIEW

4. GROUPED AND UN-GROUPED

or Shapes around an
object. To cut around
the outside of a shape
or to effect a line weight

or thickness to a raster
or scan.
B) Select the Vectored
Logo or Shape and
then Click the Offset
Polygon and have one
extra line created
around the item
(Distance = Thickness).
— C) Now Group the two
Tip” . selections and run the
Hatch graphics to see

Offset Polygon is the main way

to create line thickness or Line

the Line thickness or

weight. You can even
Process it through the
Preview to see if it

lasers correctly.

WEIGHT for Scan/Raster.

w O & M OB S %
[0 8 B - I

Offset polygon

Lines have Weight or
Thickness for Scan/Raster

Figure 2

Key Steps to our Goal

Outline to Objects:
Corel: Raster/Scan Line
Thicknesses:

1. Select an object.

2. Convert outline to object.
* The outline becomes an unfilled
closed object independent of the
original object’s fill. If you want to
apply a fill to the new object, the fill is
applied to the area which was the
original object’s outline. A star with an
outline applied; the outline has been
converted to an object independent of
the original fill; a fountain fill was
applied to the new closed object.

3. Check
Data/Preview

A) The Check Data will
not only review the line
art and objects on the
Work Pallet but will
correct items as it goes.

B) To preview processing,

use the “Preview” dialog
box by clicking

[Menu][Edit] [Preview], or

clicking the System Bar
icon. LaserWORKS
supports the preview of
the documents
undergoing processing.
C) The user can get
important basic
information from the
preview. The

preview shows the path

of the actual output of the

processing, general
processing time, &
tprocessing distance.

Figure 3

EngraveLab:

4.Group/UnGroup
A) This feature is important
as many items process to
the Work Pallet are
ungrouped and when
centered the layout can be
mis-positioned, Crtl-Z to
get it back.

B) Grouping & Un-grouping
is accomplished by
selecting a group of
graphics, or previously
grouped objects, then
entering [Menu][Edit] >
[Group] or [Menu][Edit] >
[Ungroup].

C) Items that are NOT
Lasering correctly just
need to be Un-Grouped
or even Grouped to

Process right to the laser.

Figure 4

Create your Stars for example
1. Click the Line Thickness Tool
2. Increase the Line Weight

3. Now Weld the two Lines

Together

*You can also convert an outline 7'

Figure 2

to an object by pressing Ctrl +
Shift + Q.

WATCH FOR THIS:

Data Check

Figure 1

To check graphics
data, click the “Data
Check” dialog box
by clicking the menu
command [Handle][/
data check ], or the
system toolbar icon.
When the user clicks
the “Check” button at
the lower right of the
dialog box, data
problems will be
shown in the dialog
box. The
Problems/results will
be shown in selected
stated graphics. The
data inspection
process should be
repeated until all of
the data conforms to
the requirements of
the processing.




Major
CheckPoints

RDWorks
Menu Bar |

1. Image
Library

2.Cut
Direction

3.Edit Curves

4. Arrange

Video: D16

Figure 3

Cut in and out seang

Length(mm):

Cutin
[|Enable
Length{mm): 5
Angle(degree): |45
Cut out
[FEnable

Angle(degree): |45

RDWorks Menu Bar
Features

Direction and Logo Control
Equals Quality

1.Image Library

A) The Image
Library, which is
under the ‘File”
Pull-Down Menu is
for the storage and
organization of
Logos and
Bitmaps.

B) lItis also great
to organize layouts
made in
LaserWorks for
quick reference.

C) All you do is Pull
and Drag the item
from the Image
Library to the Work
Pallet of
LaserWorks, it is
that simple.

Figure 1

Training Data Covered Here;
. LEARNED TO USE THE IMAGE LIBRARY
. Usep Cut DIRECTION
. TALKED ABOUT EDIT CuT
. TALKED ABOUT ARRANGE

NN -

“Tip” .
Have a graphics morgue for logos, and
library of high use jobs for materials

and VIP clients at the ready.

Figure 2

RDWorks Menu Bar |

2.Cut Direction

A) Cut Direction and
Optimize Cut are
two shades of the
same thing; It
controls where the
graphic starts and
where it stops.

B) To change the
processing direction:
To change direction,
click [Edit] > [Set cut
direction]. Then you
can double-click on
any position on the
selected graphic.

C) With a large job
we can make the
unit laser one area
at a time & move in
a optimal &
serpentine direction.

Figure 2

Key Steps to our Goal

Functional Control Panel

DETE]
Read

The list of files on the controller can be read
by clicking the Read button. File information
can be displayed for the documents in the list.

Download

Click Download button results in the
downloading of any number of files in the

dialogue box to the controller.

All files are selected by entering the *
wildcard for the file name while specifying .rd
as the file type. If the download is successful,

the document list will update.
Process

To initiate the controller on a particular
document, select it and click the Process

button.

3.Edit Cut

A) Edit Cut Property is
brother to CUT IN/Out &
deals more with the main

body of the vector graphic.

B) By default, a drawn or
imported curve does not
have any cut in/cut out
lines. To add such lines,
select the objects, then

use the “Cut in/out setting”

dialog box; Clicking
[Edit][Edit cut in property],
or click the icon.

C) There are two types of

the cut in/out lines: straight

lines & arcs. There are 3
Straight line cut-ins:

« Cutting in at an angle
(counterclockwise angles
are positive);

« Cutting in at the center
(cut-in line at the center)
« Cutting in at the center

(center to the starting point,

& assigning a specific
length).
Figure 3

Delete

Delete All

Cal time

Uploading

The user should click the Upload button at
I bottom right to select offline files and save

(. them to the computer.
| | \

To delete a specific file, select it and click
the Delete button. The controller will delete
the specified document.

This button automatically removes all files in
the controller & then updates the document .

Motherboard supports processing files in
terms of the time spent applying them in
laser operations. The number of hours
already spent in applying a particular file can
be calculated and displayed by selecting the
file and then clicking the Cal time button.

WATCH FOR THIS:

Embroidery File
Figure 1

In Corel there is a
Icon that can be
brought out with the
LaserWorks Power
cell ICON. This is
for Embroidery files.
Please just be aware
it is there.

4.Arrange

A) The ‘Arrange’
commands are
under the ‘Draw’
Pull-Down Menu.
This is where all the
Positioning
commands are.

B) These are the
same commands as
on the Standard Bar.
C) Learn these
commands -
specifically the
spacing and
alignment to
center, but make
sure you ‘group’
before your move
the items selected.

Figure 4




Major

CheckPoints

RDWorks
Menu Bar Il

1. System/File
Settings

2.Page/
Password
Setting

3.Show
Graphic
Hatch/Show
Array

4.Graphics
Hatch/Copy-
Paste

N
@)« Video: D17

Figure 3

Setting

3l s2ttings | System Info

e

@ Map for pen axi:

| Bar Features

Appearance and Defaults

Close

1.System/File
Settings

A) System
Settings which are
under the ‘Config’
Pull-Down Menu
are for adjusting
System
Parameters.

B) The Biggest is
X-Y Mirror and
Origin of Laser
Head. If XorY
Mirror is not clicked
the image will be
upside down and
reverse. Laser
Head control where
the layout begins
from, usually
top/right.

C) The ‘File Setting’
will control if a
DXF in Imperial or
American Inches is
about in to Scale.

It needs to be
setup for Inches.

Figure 1

Training Data Covered Here:

. LEARNED SYSTEM AND FILE PARAMETERS
. LOOKED AT THE PAGE AND PASSWORD

SETTINGS

. TALKED ABOUT VIEWS FOR GRAPHIC HATCH
. TALKED ABOUT BITMAP CONVERSION AND COPY

& PASTE

“Tip” .
Defaults must be set from upgrade
to upgrade, and the old LaserWorks

cleaned out first.

Page setting H
Page size
Page width: | B mm
Page height: | 400 e
[ ] Compensate for movable head
Head space: 100 mm
Grid
M Grdspace: S0 men
Keyboard
Adust distance: 1 mm
Adjust ratio: 10
Adust angle: | 1 S
Calor config
Background  Work area Grid
Ok Cancel

Figure 2

More RDWorks Menu

Hatch setting

Bitmap resolution; | 300

ok Cancel

dpi

RDWorks Menu Bar i

2.Page/Password
A) The Page
Settings are
Parameters that
control how the Page
or the Work Pallet
will look at the start
of the program.

B) You also make
changes or
adjustments to this
Page Setting dialog.
C) The password is
controlled by the
BOSS factory and
given out on a case
by case basis. This
allows you to get in
the area where you
could adjust the
Machining
Parameters for your

system.
Figure 2

3.Show Graphic
Hatch/Show Array
A) The ‘Show Graph
Hatch’ will fill a Box
for example, in the
color you have
chosen, only when
selected, in a Scan or
Raster mode.

B) Show Array really
has no use for me at
this time.

C) The Show Graph
Hatch, can be a clue
that you are in the
wrong Process mode
and you need to
change . This along
with the Simulator,
can save you time
and money..

Figure 3

4.Graphics
Hatch/Copy-Paste
A) Graph Hatch will
change Line art that is
Vectorized into a
Bitmap for Processing.
B) This will help to get
you around problem
graphics and layouts.
C) Copy and Paste
can be done from
within the Text dialog
within LaserWorks
Software; but all
other data must be
imported using the
Import dialog, the
Image library, and the
Power Cell macros.

Figure 4

Key Steps to our Goal

Install RDworks

Updating RDworks

When Upgrading to Newer verison of

RDWorks:

Delete the RDWorks Directories

But only these Folders
Delete V8Tem

Delete but do not empty the Trash
until we are sure we are done.

Delete the GMS files from Corel

Go to the C:\ Drive then to ‘Program
File’ and ‘Corel’ and into your verison
of Corel and under the ‘Draw’
Directory remove all LaserWorks files.

Control Panel

Remove program from ‘Programs and
Features’ and uninstall the RDWorks ...

Restart the PC

install the LaserWorks main interface
Install Corel Power Cell
Click the down Triangle and select

‘CorelDraw’and click install.
Install Corel LaserWorks

Click the Plug RDWorks and with
‘Coreldraw’ still selected, click install.
Install EngraveLab

Click the down Triangle and select
‘Engravelab, then Plug RDWorks ’
and click install.

Install AutoCAD

Click the down Triangle and select
‘AutoCAD, then Plug RDWorks ’
and click install.

WATCH FOR THIS:
Graphics Hatch
Figure 1

Sometimes when we
are working, a layout
needs to be simply
rastered to give us
the effect we wish.
We can select it and
turn it to a Bitmap or
a Section of it to a
Bitmap, and get
around a problem to
get the job out the
door.




Major

CheckPoints

Dialing
Lasers into
Materials

1. Why We
Dial Lasers in

2.Material
Library

3.Test Runs

4.Material
Properties

Figure 3

Specific Materials

Specific Setting for Our Laser

1.Why We Dial
Lasers in

A) ‘Dialing a Laser
in’ is an Industry
term that refers to
setting the Power
and Speed settings
for a particular
Material or Graphic.
B) By simply using
the General
settings provided to
you, take the laser
wattage, put in that
materials Power
and Speeds into
the Control Panel
of Laserworks.

C) Now slowly
adjust the power
and speed until you
are happy with
results. Start with
Metal and Stone,
then Plastics &

Training Data Covered Here:
| . LEARNED WHY WE DIAL A LASER INTO
MATERIALS
. LEARNED TO SAVE SETTINGS INTO LIBRARY
DIRECTORIES
3. TALKED ABOUT PROCESS OF DIALING IN
4. TALKED ABOUT MATERIAL PROPERTIES

\Y

“Tip” .
When Dialing a BOSS Laser into a
Material, us low power at first then

increase as you go.

Power and Speed for

Dialing Lasers into Materials

2. Material Library
A) Within your Hard-
drive create a Materials
library with two sub
Directories; one for
LaserWorks Jobs and
the other for
EngraveLAb or Corel
Type Jobs.

B) Save each Material
into these directories in
each format. Also,
within LaserWorks you
can save colors to
certain jobs and
processes.

C) Always have Black
as a Scan color based
on your high use
material, Red for Vector
and Blue for Alignment.
Within Corel or
Engravelab just make
notes off the page for
future reference.

Figure 2

3.Test Runs

A) Create a layout in Corel
or Engravelab that is 4 x 6
with 2 lines of text with two
different Fonts. Have a
Red vector box around the
text.

B) Put a Blue Positioning
box at 4 x 6 on the Layout
and center everything.

C) Save the job and send
it to LaserWorks to assign
the basic Power and
Speed. As stated put
Black/Scan at 700 speed
and Power at 30% with
interval of .07. Red is 50
speed at 45% power and
Blue is 700 Speed, power
at 0% and no Output. Dial
these main three color
settings into the material
Library as a Default. There
is a material Library of jobs
and Parameter already
present for your unit.

Figure 3

4.Material
Properties

A) Make sure each
material is Laser friendly.
B) You will always want
to do flat before round or
uneven. Always cut
softer material before
harder materials.

C) Once you have dialed
all the front line materials
in, make sure the Black,
Red and Blue are left set
for your high use materials.
After that when you run
into material that you have
not seen before, save the
dialed in jobs to the
material library and save
the job again for the client.

Figure 4

Key Steps to our Goal

WATCH FOR THIS:

Air Assist
Figure 1

Sometimes with two-
ply laserable Plastics
you will turn off the
Air Pump to get the
quality correct or
make second, or even
a third pass of the
material. Which with
a HP you can have it
‘Blow’ off for Scan
or Raster and On for
Cut or Vector; So
you do not get a
flame up.

. iali i P Create Test Layout
Ac(gythtizs’ W(?(?(tjs " L ainsenmns DialingiMaterialiSettings Usually two lines of text with two
an ena o = = = = . Eindi ; different fonts
as you go. Do k . LE ffg:‘nﬂglt%rgcgver CATLECSCILY Set your Speed and Power
Vectors or Cuts § BOEE Lasex —  All Lasers are a Little Different LBJSH]Q the Cheat Sheet put in the
] S .~ There is a Cheat Sheet by asic Settings for Speed and Power.
after Scan or - ftatecial Getting = Wattage of Tube, Located in the Speed before Power

Rasters, and you
will dial in Pictures
last as you may
need EngravelLab
to get the quality
you are looking for.

Once Speed is at 1000 to 1200 lower
Power in Clips of 5-10% at a time.
Do Raster for Scan First, then
Vector or Cut
Once dialed in Save the Material
settings in the Library and save the
Job into a Directory called Material
Settings for BOSS

. Pictures are different Settings

L2 Pictures will always be different
~. ‘'settings from Lettering or general

Back of the Manual

~ Treat each material like a
Haircut, you can always take off
more or increase the Power

~ Power & Speed are in
relationship to one another

~ Dial in Metals before Plastics or
Woods

Figure 1

Figure 2

N
@)« Video: D18




Major
CheckPoints

Laser 101

1. Optics

2.Motion
System

3.Electronics

4 Cabinet &
Z Axis

< Video: D19

Figure 3

1.0ptics

A) The Optics
System is made up
of the Laser Tube,
the Mirrors and the
Lens; plus
supporting lens and
mounts.

B) The Laser Tube
generates a laser
beam that has
friction. This Beam
goes through a
combiner lens that
marries it to the red
diode light to the
beam.

C) From there the
Laser beam hits
the primary mirror,
then to top the
bridge mirror and
lastly to the lens
mirror. The beam
alignment on the
mirror mounts
control the angle of
the beam. It finally
goes through the
lens (Convex side
up) to the material
at its focal length
usually 2.5 inches.

Figure 1

Training Data Covered Here;
| . LEARNED THE OPTICS OF THE LASER
2. RECEIVED INFORMATION ABOUT THE MOTION
SYSTEM

3. TALKED ABOUT THE ELECTRONICS
4. TALKED ABOUT THE CABINET AND THE Z-AXIS

PLATFORM.

“Tip”

There are Flying Optics units which are
Class One (Closed Cabinets) and Class
4 (Open Cabinets) Plus Galvo unit,

which are spinning mirror lasers.

Rear Component Assembly
- Easy Access

- Electrical Breakers

- Board Stack

- Drivers

- Exhaust

Figure 2

How Lasers Work

Main Systems of Class | & 4 Laser

2.Motion System
A) The main Job of
the Motion is to carry
the laser beam to
where the Controller is
told to carry it.
Whether it's for
Vector(Cut) or Raster
(Scan).

B) There are three
driver boards in the
Electronics board
stack that send signals
to the motors.

C) X is the Left/Right
Travel and Y is the
Back/Forth Travel. Z
is the travel of the
Platform for Focus and
clearance of materials.
The Belt on the X
Bridge connects to the
Lens Carriage and
complete the system.

Figure 2

RDWorks Training

Laser 101

3.Electronics

A) Electronics is the Muscle
of the system and the
Graphical interface,
LaserWorks is the Brains.
B) There are two Shift-mode
power supplies; one for the

Tube and one for the system.

They take A/C Voltage and
convert into D/C voltage.
This power is sent to the 3
driver cards that pass it on to
the motors and limit switches
that help with the control of
the motion system.

C) The LaserWorks
Controller is the core of the
system and sends logical
signals to the system to tell
the tube went to fire and for
how long. This in concert
with the motion system is
where the processing is
performed. These
components are all marked
as to where they go and
what they do.

Figure 3

4.Cabinet & Z Axis
A) The Cabinet holds the
Tube in the back top, the
electronics to the right side
and Motion system and
Optics inside .

B) The Z- Platform is the
Table that rises and lowers
either controlled by the
Operator or by the Auto-
Focus Function, and is there
for Focusing the material to
the focal length of the lens.
C) The Balance of the
cabinet is the exhaust and
wiring. Make sure
everything you use to align
the material or square has
air flow so the fumes can
escape.

Figure 4

Key Steps to our Goal

General Laser Syste

-~ The Motion System is built into the
Cabinet and is under the control of the
Electronic Board Stack which in turn to the
main Controller board that reads the
signal from the PC Graphical Interface.

# This signal will control where the Lens
Carriage travel to; and whether you cut or

Scan.

#° The Controller also directs the Laser
Tube to Fire relaying timing and intensity

of Power.

.~ The Optics system delivers the beam to
the Mirrors mounted on the Motion

system.

# This way the beam may travel through _
the mirrors of the flying optics systems t

the Lens.

Focus

material.

Controller.
Cabinet

The Platform of the Laser will rise or
lower to a focus length of the lens to

The physics of a Laser Beam
Laser Beams come down to the
material like an Hour Glass and the
focal length is in the middle of the
hour glass and is the hot spot. Too
Close or too Far and no Burn or
quality burn will result.

The Laser Pendant

This controls the ‘Origin’, Auto-Focas
and File Delivery of information to the

Houses all and traps the Fumes to
exhaust to the outside air.

WATCH FOR THIS:

Laser Tubes
Figure 1

upplied in
the form of light (flash lamps or
diode ) or by electr

fluorescent lamp). The
rod or

that directs the laser light into a
specific dir n and amplifies
it in this manner. A defined

used for melting or evaporating
the material. In addition, using
suitable optics (mirrors), laser
light can be directed and
1cﬂentcd and this completely
even over

free tool as the laser beam will
never beLumc blunt.

r, and it can
head! This
in the case
01 ( 02 Laser 40 volts is
applied with the Tubes power
supply and generate the laser
bedm out the mbe to 1he first

en
Red Diode light to the bedm SO
ee where it will go. It
m that mirror to the
Bridge mirror on the side of the
Bridge to the final M: and
down through the lens.




Major
CheckPoints

PC 101

1. Windows

Explorer

2.Systems
Tray

3.Electrical

4 Maintain the
OS

Video: D20

Figure 3

Properties

Open Windows Explorer

1.Windows
Explorer

A) Windows
Explorer is your

File Manager, so
learn it. It is also

used to install
new Truetype
Fonts.

B) Right Mouse
click on the Green
Start Icon of
Windows and
click on Explore;
you can click on a
file & hold down
the Left Mouse
Button and Drag it
into another
Directory. If you
hold the Ctrl key
you can copy a
file to a new
directory.

C) You will see a
folder and see
that folder has
Sub-Directories
and so on. This is
the structure of
the organization
Tree, and folders
can be created or
deleted as you
need them.

Figure 1

How Personal
Computers Work

the Core of Your OS

Training Data Covered Here:

| . LEARNED ABOUT THE WINDOWS EXPLORER

2. RECEIVED INFORMATION ABOUT THE SYSTEMS TRAY

3. TALKED ABOUT THE ELECTRICAL HOOK uPs

4. TALKED ABOUT THE PREVENTATIVE SUPPORT FOR THE PC

“Tip”

Isolated Line for your Electrical and

good Surge Protector is a must for the

life of your PC. .
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2. Systems Tray
A) In the bottom right
corner of your PC
screen is the Time and
Date on most PC'’s.
B) Many other Icons
may be a there, click
down Triangle to show
Hidden Icons.

C) This is the
Systems Tray and it
shows the major
Programs running in
the background. If
you Right Mouse click
on the icon, there will
be a command that
you can use. You can
exit the program or
make changes to its
status, this is a main
area of Windows.

Figure 2

PC 101

3. Electrical

A) Your Electrical setup or
how you plug into the A/C
power cords is important to
the longevity of the tube and
Equipment and the
components of the PC.

B) The Laser should be
plugged into a Isolated line,
that has nothing, but the
Laser/Chiller and Computer
receiving current from that
line. You can go to the Fuse
box and turn off the breaker
for the Laser and the only
thing that goes off is those
units.

C) If that is not possible,
then no big stuff like
microwaves, refrigerators,
Coffee Makers etc. You
must put the Laser and the
Chiller on a ISOBar Surge
protector and the exhaust
and pump on another one
so you can turn off those
units without turning off the

Figure 3

4.Maintain the OS
A) To Maintain the OS you
must have a Good Anti-
Virus, | Like McAfee, and
have a PC with min 8 gigs
of ram, 16 if you can get
based on Window 8 and
750 GIG HD.

B) You should run the
‘Clean Disk’ program of
Windows once a Month
and set the Anti-virus to
scan Weekly.

C) If I need the PC online
to help support you, we will
use ‘SHOWMYPC.com as
support interface. With that
| can hook up to your
Computer. You need to
Tune the Laser up once
every other year and the

Figure 4

Key Steps to our Goal

Search Commands

A) If searching for a file, you can ask
the Windows Explorer to search for
it for you.

B) Especially, go to the search
section which is a little different on
each Operating System (OS) and
type in the File name you are looking
for.

C) You can also use Wild Card
commands to give you bigger search
parameters like C*.BMP, which say
search for all Bitmaps that begin with
‘C’. There are other parameters that
will narrow the search for you, like

Date, directory, etc. They are great .

time savers.

Once in the Windows
Explorer

This is your File Manager

* You can make Extra Folders for
Jobs(.CDL) or RD JOBs from
LaserWorks

* Click and Hold down the Left Mouse
Key to Drag Files

* Then drag files to other directories
highlight them and let go and the file
will move, also if you hold the Ctrl
key on the KB down it will copy the
file, leaving the original alone.

Make a main File Cabinet for
.Engravelab jobs/LaserWorks, and a
Sub-Directory where your Logos will be

kept.

WATCH FOR 'l‘lllb:

File Manager
Figure 1

A) You can Right
Mouse click and
Copy a file, then
click on the
directory you wish
and Paste it in.

B) Keep the
file(s) in Common
Directories with
Folders and Sub-
Folders this allows
easy Back-up of
high use files.

C) The way you
organize your files
whether they are
Jobs or Clipart will
save you a lot of
time and effort.
Again the Sub-
directories under
a main directory
that deal with
what you are
doing. Client Files
in Client Folders
and under Clipart
areas.




Figure 3

Major
CheckPoints

Rulers ‘
.1/8 to 1/4 Thick *=

How to Make a
Positioning Table

WATCH FOR THIS:
Making a Ruler
Figure 1

Bottom Securing Rails

Spacers >
<«——for High Speed_——
JOBS

Making a
Positioning
Table

Make Positioning Simple

Making a Positioning Table

A) In Engravelab
there is a Ruler
Tool. But in Corel it
is pretty easy, as
well.

B) There is a Grid

1.Top Rails Training Data Covered Here: 2. Bottom Holders  3.Test Run 4.Pendant tool used to set in
. ) . PUT THE RAILS AND RULERS TOGETHER tﬁg ';:?neer g;:g:iii:?gs A) Once the Grid is A) Now the Table is in Place your marks every
. Top Rails A) With Your . Put THE BOTTOM RAILS HOLDER ON ones, 6 for the Le¥t and 6pfor squared up jog the Red use the Pendant again to

2.Bottom
Holders

3.Test Run

BOSS Laser you
received a Grid
Cut-out table; we
are going to add
rails to it, on the top
to act as Rulers
and ridges to butt
the material up

NN -

. RAN TESTS
. USED THE PENDANT TO FINALIZE THE PROCESS

the Right. Mount them on
the bottom of the Grid Cut-
Out table on the outsides
under the ruler-ed rails
squared to them .

B) Put a strip of a Steel
Laser Brass 2 inches
shorter than the Industrial
Wedge Rails, Tape it to the
2nd Industrial Wedge (on
the flat side) on the Left and

positioning pointer light
left/right across the grid at
the Zero point and
back/forth on the Y-Axis to
verify it is square.

B) Once you are very
sure that you can remove
the Grid table and replace
it in the same spot and it
is square by jogging the

jog the Red Diode light from
its position across the X/'Y
Axises.

B) There will be some play
in the grid Table, just push it
up and to the right . To get a
standard position, shim it up
to hold it in place with your

inch. Type lower
case ‘L’ in Aerial.
Place it at the
intersecting grids.
C) Now with your
Duplicate amount
set to one Inch hit
Ctrl-D on the
Keyboard until

against. Right Sides towards the position light across the
. outside. . magnets or Steel Plates.
B) Dependmg on C) Remove the Far axis at the ZerO/.Ze.ro C) You may have to run you are at 30
the Table Size Industrial Rails from the point, set the Origin to marks for 16x30
4.Pendant ) base of the Tables; from the the that Top/Right corner ~ another test plate and
Vector Cut 3 X- : P/RIg for example. Now

N
@)« Video: D21

axis rails, one of
which can have a
ruler lasered into it.
Make these .850
wide and length of
the Grid (minus
1.7)

C) Cut 6 Y-Axis
rails, the total
length of the Y-
Axis; two of them
with the Rulers for
the Left and right.
Now double-side
tape them onto the
Grid Edges, Y-axis
first then the X-axis
into the middle .
Do this one Layer
at a time Left, Right
then Center, putting
the rulers on last.

Figure 1

“Tip”

A position Table is not a must but can
ease the process of aligning material to
the Laser. We do have more advanced

tables that can be purchased.

Figure 2

left and right sides. Double-
side tape 2 Badge Magnets
to the inside of the new
Plastic Bottom Rails towards
the bottom and top areas.
The Table should set into
the area where we removed
the Wedges and magnet up
to the second wedges too.

Figure 2

of the Positioning table.
C) Now put on a 2x4 test
plate and Vector/Cut a
Capital ‘L’ in a Single Line
font with a 1” baseline and
1” from the Left Margin
and check it, adjust your
Origin point as needed.

Figure 3

adjust the origin again if you
have to pull the table out to
gain Z- Travel area for thick
pieces, if you need to
repeat the final testing, you
use the same shim in the
same place.

Figure 4

Key Steps to our Goal

Why a Positioning Table The Industrial Positionin

Table

A) If you need to square up your

Material, the Positioning Table is the

way to go.

B) It allows us to square up materials
and Jigs and gives us an easy to find

Origin Point.

C) | can butt up against the Left or
Right rails and put in cheater spacers
to push the Left, Right or even top
origin into the center. This is a big
thing as | increase speed and get
over travel.

Has the more polished Ruler Rails

for both Metric and Imperial.
* |Is a Magnetized table with

anywhere.

table surface.

*

additional 6 inch moveable rails that
can be placed on the table

* There are Dowel pin holes every
1/2 inch for air flow and to put the
Dowel pins into for either butt up
against or to raise objects off the

Call us today to order one.

do the 1/2 mark,
half size and 1/4
marks quarter of
the size. Next put
in the numbers the
same way. For
left/right just do
the same thing put
the number to the
outside.




Major
CheckPoints

Project Basic
Job

1. Basic Five
Steps

2.Plate Size &
Text

3.Fonts &
Alignment

4 .Corel to
EngravelLab

N
@)« Video: E22

1. Basic Five
Steps

A) All Graphics
fall into 5 Basic
steps; the first
and most
important is the
‘Size of Plate’
then Text on
Screen, Change
Fonts, Resize,
Reposition.

B) You will need
to make sure you
have set your
Origin to the
top/right of the
Plate or where
the Origin Point
is in LaserWorks.
C) Once the
Layout is
finished, you can
press ‘File’ on
the Pendant and
select the Job.
Then press the
‘Frame’ Key and
watch the Laser
find the
Perimeters of the
outside of the
engraving area.

Figure 1

Figure 3

Making A Basic Job In

RDWorks

Simple Tools for an Easy Task

Training Data Covered Here:

. TALKED ABOUT THE FIVE STEPS OF A JOB.
. INPUT THE SIZE PLATE, ADDED THE TEXT AND

CHANGED FONT.

. RESIZED AND REPOSITION
. TALKED ABOUT MACHINE SETTING AND POWER

SPEED ASSIGNMENTS.

“Tip”
The Five Steps to create a job in
LaserWorks are the same as
CorelDraw or Engravelab: Size of
Plate, Text on the Screen, Change
Fonts, Re-Size, and Re-position!

Boss Laser L] 2
BASIC
Job

Figure 2

Boss Laser

BASIC
Job

Project Basic Job

2.Plate Size & Text
A) Draw box with the
‘Rectangle Tool’ and size
it to (Step One) Plate Size
and move it into a corner
for now.

B) Click on the ‘Text Tool’
and type out your line of
(Step Two) text, repeat
this for each line you
wish, Check your
Spelling.

C) (Step Three): While in
the ‘Text Tool’ dialog you
can change your Font to
truetype or Single Line,
and control kerning and
size. Do not have the
Rectangle Selected, if so
click ‘No’. Once on the
Screen select all the
Letters and ‘Group’ them
by clicking on the ‘Group’
Icon’ on the Standard Bar.
Again, Verify that all is
typed correctly before
moving on.

Figure 2

Key Steps

3.Fonts & Alignment

A) if you need
different fonts add
them one line at a
time, be sure to add a
2nd box color to the
outside BOX blue
and inside box red.
B) The Text will come
from the Text Dialog
box and size of the
rectangle was
determined by you
when you drew them.
C) Select All using
the Ctrl-A Key and
click the ‘Center to
screen’ icon on the
ToolKit or Edit Bar on
the Left.

Figure 3

4.Corel to
EngravelLab

A) Usually you will use
Corel or EngravelLab
to create layouts and
just send them over to
the Graphical Interface
that is LaserWorks.

B) You will need to
assign the ‘BLACK’
as your Scan or
Raster color; assign
30% Power and 700
on the Speed with
the Interval at .07.
C) Red is the Cut or
Vector Process at 50
Speed and 45% power.
BLUE is at 0% Power,
700 Speed and NO
OUTPUT.

Figure 4

to our Goal

5 Basic Steps to a Job Pendant Quick Steps

A) Put in the Size of Plate in this
case the BLUE Vector Box.

A) Save Job

B) Assign Process Power and Speed

B) Add the Text and make sure it is

correct.

C) Change Fonts, if needed

D) Re-Size text and Objects

E) Re-Position the Layout

C) Download to Laser

D) Check or Set Origin Position

E) Press the ‘File’ on the Pendant

F) Select the Job you want

G) Press the ‘Frame’ Button

\H) Press ‘Start’

WATCH FOR THIS:
SENEYY

Figure 1

A) Make sure the
Fume Exhaust
and Air Pump are
running.

B) If you get a
Flame up just stop
the job or raise
the lid.

C) Never walk
away from the
laser while in
operation.




Figure 3 _
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Making a Plastic Sign  [=:2 = -
In RDWorks _

Major
CheckPoints

WATCH FOR THIS:
Importing Logos
Figure 1

Project
Plastic Job

1. Layout —
Quick Steps

2.Color
Properties

3.Logos and
Shapes

4.Power -
Speed Review

N
@)« Video: E23

1. Layout — Quick
Steps

A) Draw box with
the ‘Rectangle Tool’
to 200 x100 MM
and color it Red we
will be cutting these
out.

B) Import your
Logo, and size it
and place it to the
Left side of the
Plate.

C) Click on the Text
Tool and Type your
First Line of the
text. Change the
Font. Do the
same for the
second line and
change the Font.
The two evolutions
are due to the font
change. Now
group first and
second lines and
center them to one
another, and Group
again. Lastly, place
it to the right side of
the Plate and
position it. Now
Group whole layout
and center to the
Work Pallet.

Figure 1

Training Data Covered Here;
. DID A LAYOUT OF A PLASTIC JOB.
. ASSIGNED POWER AND SPEED BY COLOR.
. REVIEWED IMPORTING AND SHAPES.
. TALKED ABOUT PRECAUTIONS AND FOCuUs
TRICKS.

NN -

“Tip”
Plastic settings will be very close to
Wood. The setting for Photos will vary
from the main Plastic Settings.

DIRECTOR OF OPERATIONS

YY semm———

Figure 2

Plastic Signs and Name Plates

Project Plastic Job

2. Color
Properties

A) Ungroup the layout
and color the text Black
and the Vector Box Red.
B) The Black should be
500 on Speed and 55%
on Power based on a
100 watt, if not dial the
unit for your wattage,
make your interval .07.
C) For the Red Cut box
use 65% Power at 55
speed based on 100
wattage tube. Run a few
tests to verify the
quality. Also you may
have to turn off the Air
pump for the Raster or
Scan to keep the fume
from staining the
lettering. Just download
selected only and run
the vector separate as
you need the air for that.

Figure 2

3. Logos and
Shapes

A) Importing of
Logos falls into two
categories: 1 -
Bitmaps (.BMP &
Jpegs; 2 - Vector
images (.DXF &
Al).

B) With shapes
that come with
LaserWorks get
used to drawing
and sizing them in
Metric.

C) For Shapes not
there that you may
need, just import
them as you see fit.

Figure 3

4. Power-Speed
Review

A) With Power and
Speed the number one
concern is quality and the
one mistake made is that
it is out of focus.

B) Make sure that the
Auto-Focus is correct by
checking it with the
Manual Focus tool.
Usually if you change
materials or you are
doing Glass or Acrylic
then focus on every
Piece - they will change
without warning.

C) With Plastics you may
lower the platform just
little to widen out the
beam, for effect.

Figure 4

Key Steps to our Goal

5 Basic Steps to a Job Pendant Quick Steps

A) Put in the Size of Plate in this
case the BLUE Vector Box.

A) Save Job

B) Assign Process Power and Speed

B) Add the Text and make sure it is

correct.

C) Change Fonts, if needed

D) Re-Size text and Objects

E) Re-Position the Layout

C) Download to Laser

D) Check or Set Origin Position

E) Press the ‘File’ on the Pendant

F) Select the Job you want

G) Press the ‘Frame’ Button

\H) Press ‘Start’

To import a file,
follow the
procedure below.
Click menu [File] >
[Import], or click
the icon, to use
the following
dialog box

Then select a file
and click open or
preview to see a
particular file.

For most vector
files, the RDWorks
v8/LaserWORKS
v8 software will
automatically
import the file into
the corresponding
layer of RDWorks
v8/LaserWORKS
v8 according to
the layer
description.




Major
CheckPoints

Project
Stone Job

1. Layout —
Quick Steps

2.Photos
3.Positioning

4 Simulation
REVE

N
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Figure 3

1. Layout — Quick
Steps

A) Draw box with
the ‘Rectangle
Tool’ to 300x140
MM & color it
blue but we will
NOT be cutting it
out.

B) Import your
Photo in and size
it. Then place it to
the Left side of
the Plate.

C) Click on the
‘Text Tool’ and
then type your
Line of text &
change the Font.
Now group the
line and center it.
Place the right
side of the Plate &
position. Next
select the line of
text and hold the
Ctrl key and hit
your right arrow
key to slant the
text within the
plate. Now Group
whole layout and
center to the Work
Pallet.

Figure 1

In RDWorks

Stone: Marble-Granite-Tile

Training Data Covered Here;
| . LAID-OUT A STONE JOB
2. PROCESSED A PHOTO FOR LASERING ON A
DARK SURFACE.
3. RESIZED AND REPOSITIONED.
4. SIMULATED THE LASER PROCESS.

“Tip”
Good marble and granite is must. To
get great results with photos use

EngravelLab: Laser Photo Plus.

Figure 2

Making a Marble Plate

o,

~

ES CAGNEY 33USA

2. Photos

A) Import your Photo
into the LaserWorks
software, SIZE it and
place it into the left side
of the plate or within
the Blue Box.

B) The Photo must be
at size before this next
process. Select the
Photo and click the
‘Bitmap Handle’ on the
Standard Bar.

C) The Dialog will come
up. Click the ‘Dither’ as
we are lasering this
onto Black Anodized
Aluminum. We need to
invert it so click the
invert and click ‘OK’.
Once the screen
refreshes you will see
the invert and dither on
the Work Pallet.

Figure 2

3. Positioning

A) Recheck all your
positioning for this
layout.

B) Align the photo
to the center left of
the Blue Box or
plate.

C) Align the angled
text to the right
center using the
Position tools on the
Positioning Bar of
LaserWorks. Always
regroup and center to
the Work Pallet. Now
Save the job assign
the Power and
Speed as shown in
the Graphics

Figure 3

Project Stone Job

4. Simulation
Review

A Select your layout
and up in the Standard
Bar to left side you will
see a ‘PC’ screen, Click
onit.

B) This is the
Simulator, when
hooked to a Laser it will
tell how and where the
laser will perform each
task assigned.

C) Slide the ‘Default &
Simulate’ to the right to
speed up the process
and click the
‘Simulation’ Tab. You
see the Bitmap Laser
first and the Text per the
Control Panel Order.

Figure 4

Key Steps to our Goal

5 Basic Steps to a Job Pendant Quick Steps

A) Put in the Size of Plate in this
case the BLUE Vector Box.

A) Save Job

B) Assign Process Power and Speed

B) Add the Text and make sure it is

correct.

C) Change Fonts, if needed
D) Re-Size text and Objects

E) Re-Position the Layout

C) Download to Laser

D) Check or Set Origin Position

E) Press the ‘File’ on the Pendant

F) Select the Job you want

G) Press the ‘Frame’ Button

.H) Press ‘Start’

WATCH FOR THIS:

Bitmap Handle

Figure 1

The Bitmap Handle
function sets image
characteristics of
images as size,
resolution, brightness,
contrast, and color.
The “Bitmap handle”
dialog box,click the
icon, select a bitmap,
and then click [Menu][
Handle] > [Bitmap
handle], or click the
icon. The top right of
the dialog box displays
the information.
[Apply to view]. Click
the [Cancel] button at
bottom right of the
dialog box can be
pressed to return to the
original image. This
option is good for trial-
and error adjustments
to an image.

[Apply to source]. A
sequential processing
saves computing time
for follow-up
operations.

[Save as]. Image to be
exported/saved to the
hard drive. [Apply to
view]. In general, use
the [Save as] function
to facilitate subsequent
processing.

[Gray scale]. After the
gray scaling has been
done, the user should
click the [Apply to
source] button. It is
important to remember
that gray scale requires
less memory than a
colored image, For
color images, adjust
contrast and brightness
to have some auxiliary
effect to following
dither processing.



. Figure 4
Figure 3
Major ) 1 Making Acrylic Awards L WATCH FOR THIS:
w In RDWOI’kS MNum: | 3 ¥Space: | 0.200 Array
YMum; | 3 YSpace; | 0.200 Figure 1
Project
Acrylic Job Shar: M Acrylic cuts show great Quality ! Sestrew.. ok S To replicate object

1. Layout —
Quick Steps

2.Array

3.Logos and
Shapes

4 .Advanced
Cut Controls

N
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1. Layout — Quick
Steps

A) Draw box with
‘Rectangle Tool’ to
132 x123 MM and
color it Red as we
will be cutting it out.
Now use the ‘Edit
Node tool’ to
remove the
Top/Right corner
node to make a
Triangle as shown.
B) Import your
Logo in and size it
and place it to the

center of the Shape

and color it light
Cyan.

C) Click on the Text
Tool and the Type
your text Line and
change the Font.
Now group the line
and position it
towards the bottom
of the shape. Next
select the line of
text Color it Black,
now Group whole
layout and center it
to the Work Pallet.

Figure 1

. MODIFIED SHAPES.
. TALKED ABOUT LAYOUTS WITH MORE

NO

Project Acrylic Job

ina BOSS Laser
Training Data Covered Here: 2. Array
. LAID OUT AN ACRYLIC AWARD JOB. A) Place your Group
2. PROCESSED A MATRIX OR ARRAY TO Layout to the
DO MULTIPLES ON SHEET OF MaTERIAL.,  1oP/Right comer of

your Work Pallet.

B) Select it and click
on the ‘Matrix Copy
Tool’ on the bottom of
the Tool-Kit or Edit
Bar.

C) Type into the
Dialog 3 on X and 3
on Y with .200 gap on
both. Now click OK
and you will see an
Array form, Populating
from Right to Left and
down into a row of 3
and columns of 3.
Select All-Via Ctrl-A
and Group them. Now
center the Array to the
Work Pallet.

THAN ONE SCAN COLOR.

“Tip”
There are Two Types of Acrylic, Cast
and Extruded, ASK for what is best for

Cutting and what is best for marking.

Figure 2

saLsTmNY E—— case the BLUE Vector Box.

: Key Steps
5 Basic Steps to a Job Pendant Quick Steps

A) Put in the Size of Plate in this

3. Logos and
Shapes

A) Shapes that you
can draw in
LaserWorks, can
modified with Edit
Node tool.

B) By simply adding
or removing nodes
or moving nodes to
different positions
you can change a
shape to your
liking.

C) If you Click and
hold on the Edit Node
Tool, it will show you
an additional menu
along side the Tool-kit
for you to use in
Modifying Vectors.

Figure 3

A) Save Job

4. Advanced Cut
Controls

A) Change the Power
and Speed setting per
the Graphics on this
page.

B) Notice we have more
than one Scan or
Raster color allowing us
to put two different
power depths into the
layout. If you control
scan power in many
parts of a layout you
can make a 3D image
into Acrylic or Wood.

C) For Cutting metal
there is a ‘Laser through

mode’: Only use this
for Stainless.

Figure 4

to our Goal

B) Assign Process Power and Speed

W : B) Add the Text and make sure it is

correct.
C) Change Fonts, if needed
D) Re-Size text and Objects

E) Re-Position the Layout

Figure 2

C) Download to Laser

D) Check or Set Origin Position

E) Press the ‘File’ on the Pendant

F) Select the Job you want

G) Press the ‘Frame’ Button

\H) Press ‘Start’

arrays, the “Array
copy” should first copy
the object by clicking
the Edit Bar, and using
it to select the object to
be copied. The user
then opens the “Array
copy” dialog box by
clicking the icon. The
user can replicate an
array in different
directions. The
direction of copying is
based on the original
graphics. After setting
the array number and
array spacing, the user
can click the [Apply]
button to see the
actual graphics array.
There are two forms of
array spacing, center
spacing and edge
spacing. To choose
center spacing, the
user must use the [X
Distance(mm)] function
to define the horizontal
distance from the
center-point, and the
[Y Distance(mm)]
function to define the
vertical distance.
Spacing can be
adjusted by inputting
values directly and
then clicking [Apply].
The user can also
press direction keys to
adjust an object’s
spacing. The user can
evaluate the
orientation of an object
inside the work area by
clicking Check
[Center].




Major
CheckPoints

Project Wood
Job

1. Layout —
Quick Steps

2.B/W
Bitmaps &
Outlines

3.Vector
Cutting

4 Air Assist
Tricks

N
@)« Video: E26

Figure 3

Making a Wood Job
from a Vector In
RDWorks

1. Layout — Quick
Steps

A) Draw a box with
the ‘Ellipse Tool’ to
109x49 MM & color
it Red as we will be
cutting it out.

B) Import your
Bitmap & size it
and place it to the
center of the
Shape. Click on the
Bitmap Handle and
Convert to a B/W
Bitmap.

C) Now click on the
B/W Bitmap and
click the ‘Bitmap
Handle’ again to a
‘Get Outline’. Next
ungroup the Vector
logo and remove all
but the Maple Leaf.
Center over the
Bitmap. Now color
the Maple Purple.
Do this so you can
control it's
vectoring out. Now
center it so it cuts
the outside of wood
last, so it remains
in Focus.

Figure 1

Training Data Covered Here;
. LAID ouT A Woob JOB
. PROCESSED A BITMAP TO A VECTOR
. MODIFIED THE IMAGES
. TALKED ABOUT AIR ASSIST TRICKS

NN -

“Tip”
Changing Bitmaps, especially B/W
Bitmaps to a Vector line can be done in
LaserWorks with 300 DPI Artwork, but
you can also use Corel or better yet
EngravelLab, which is best in the World.

Figure 2

Vectoring Bitmaps is a Art Form

Project Wood Job

2. B/W Bitmaps &

Outlines
A) For LaserWorks
Black/White Bitmaps will
laser more easily than
Grayscale or Dithered.
So if you convert to
Black & White and you
like the image that is the
way to go.
B) B/W Bitmaps will
also Vectorize better,
when you click ‘Get
Outline’ in the ‘Bitmap
Handle’ Dialog Screen
this will give you an
outline vector.
C) To Vectorize a
Bitmap with ‘Get
Outline’ & still Scan or
Raster with the Laser,
the Process is your
choice; a combination of
Bitmap and Vectoized
Image for Scan and Cut
can be Powerful.

Figure 2

3. Vector Cutting

A) With Shapes that
you can draw in
LaserWorks, those
shapes can be
modified with Edit
Node tool.

B) By simply
adding or removing
nodes or moving
nodes to different
positions, you can
change the shape
to your liking.

C) If you Click and
hold on the Edit
Node Tool it shows
you an additional
menu along side the
Tool-kit for you to use

Figure 3

4. Air Assist
Tricks

A) The Quality of Air
Assist is shown when
rastering Plastics, but
can also be used with
woods.

B) You can pulse the beam
within the Cut Process &
control the volume of air
that is going to the nozzle.
C) With LS Models
you have to run the
project as two
separate jobs, use the
‘Selected only’ feature.
With HP you just turn
off or on the ‘Blow’ in
your Process dialog in
the Control Panel.

Figure 4

Key Steps to our Goal

5 Basic Steps to a Job Pendant Quick Steps

A) Put in the Size of Plate in this
case the BLUE Vector Box.

A) Save Job

B) Assign Process Power and Speed

B) Add the Text and make sure it is

correct.

C) Change Fonts, if needed

D) Re-Size text and Objects

E) Re-Position the Layout

C) Download

to Laser

D) Check or Set Origin Position

E) Press the

File’ on the Pendant

F) Select the Job you want

G) Press the

Frame’ Button

H) Press ‘Start’

WATCH FOR THIS:
Outline Vector
Figure 1

A) Import a Bitmap
into the Works
Pallet.

B) Select the
Images and click
the ‘Bitmap
Handle’.

C) Convert to B/W
Bitmap or
Monochrome.

D) Then Click ‘Get
Outline’

E) Clean up with
the ‘Edit Node
Tool’.




Figure 4
Figure 3 . E— igure
I(\;"hajokrp . Making a Control Panel ; . WATCH FOR THIS:
eckPoints Oftst poy ‘ . .
SRR In RDWorks oo mmrreeny N/4 Inline/Outline
% A Figure 1
Project 5 | o
Control Control Panels show you mastered P E——
Panels this Interface Outline Shape
Project Control Panels B) Click the ‘Offset
- = = Polygon’ Tool
1. Shapes — Quick Training Data Covered Here; 2. Position & 3. Color Controls 4. Review C) Click inside or
Steps | . LAID OUT A CONTROL PANEL JOB Arrange A) The Color A) For Control Panels outside or both
1. Shapes - A)D b ith 2. USED THE POSITIONING AND TOOLS TO CREATE A) Positioning is the Controls are very produced within
i raw box wit THE LAYOUT. key feature of a Control  jmportant to this type LaserWorks itis possible D) Put in the offset
LB e the ‘Ellipse Tool to 3. ASSIGNED POWER AND SPEEDS FOR CUTOUT Panel, usually you get of job. as long as you have nge

2.Position &
Arrange

482 x 215 MM and
color it Red as we
will be cutting it out.
B) When doing a

IN

AND MARKING.
. REVIEWED THE MAIN RESPONSIBILITY
OF LASERWORKS.

that information from
the client, but in this
case you get to Eye
ball the Graphics and
from the sample job
(CP.rld)

B) Cut or Vector is
not always about

Cutout, in this case,
we are scoring lines

learned the tools in
question.

B) But Creating items from
CorelDRAW and/or

E) Click Ok now
select the Two
layers and group

Control Panel you
have cutouts and
score lines. Draw
all the cutout first
then the score
lines; boxes then
circles.

C) Use the Matrix
Copy to Duplicate
columns and Copy
& Paste to produce

for effect and for
positioning of the
hardware to the
panel.

C) So we need
different Power/
Speeds to get the
effect we are looking
for. Please plug in
these Power and
Speeds per the

Engravelab would make it

B) Watch the Standard
Bar for the position
measurements.

C) You can align items
to one another then
position the group. All
is referenced from the
Top/Right using the
outside cutout as an
Origin point. But you
can change the
reference or Origin

them together

much easier.

C) As stated LaserWorks
is not a Graphics Layout
Program it is a Graphical
interface which its main
Job is to assign Power
and Speeds to different
colors within the Control
Panel and Send that

3.Color
Controls

F) Change to a
Scan Color or
change the

“Tip” Process to Scan.

4 Review Engraving Control Panels, because of

H) Now your Line
has Weight or
Thickness to your

: : I . . N . Layout to the Laser. Itis it
sized copies. You conquered all positioning skills with the Point to check position graphics. Print Driver on Steroids It.
will need the ‘Edit program. as you see fit. i '

Figure 2 Figure 3 Figure 4

the all the Position we must do. They

are considered to be sign that you have

Node Tool’ to round

your corners and to K St t G I
break the inside ey e pS O O U r Oa
border for the logo. ;
. i Pendan ick
Color in the areas 5 Basic Steps to a Job endant Quick Steps
as you go and : JmEz:: A) Put in the Size of Plate in this A) Save Job
save, save, save! BOSS/ M:=:: case the BLUE Vector Box. )
The ‘Edit Node tool’ | % _— B) Add the Text and mak " B) Assign Process Power and Speed
: H A e Iext and make sure It Is
;N.I“ gl\lle yoct; a g — - TTEE C) Download to Laser
riangle and you E
can create the B % C) Change Fonts, if needed D) Check or Set Origin Position
Logo with the ‘Text |1 =~ = . T
Togl’. Lastly the 7 —c— 8 = = A D) Re-Size text and Objects E) Press the ‘File’ on the Pendant
Offset Polygonwill 1L = E) Re-Position the Layout F) Select the Job you want
be useful for Line ]

thickness or G) Press the ‘Frame’ Button

weights.  Figure 1

Figure 2

\H) Press ‘Start’

N
@)« Video: E27




Figure 3

Major

CheckPoints

Cleaning
Optics

1. Cleaning
Solution

2.Lens

3.Lens
ASSEMBLY

4 Mirrors

N
@)« Video: F29

1. Cleaning
Solution

A) Only use the
Cleaning solution
that is recommended
by BOSS.

B) In this case it is
Camera Lens
cleaner, and apply it
with a moist lint free
cloth.

C) Do not ever
clean dry. Pad the
Optics with a wet
area to remove any
materials from the
optics prior to
rubbing it clean, so
you do not rub
particulates Into the
optic. So when you
rub the Optic do it
with another area of
the Cloth. Lastly,
wipe the Optic with
the dry lint free cloth
again.

Figure 1

OPTICS

LENS.

MIRRORS.

Cleaning Your Optics |
is a Daily/Weekly Event [0

Maintaining Optics is Important
to Quality

Training Data Covered Here:

. PROCESSED THE CLEANING OF THE

IMPORTANT RESPONSIBILITY.

“Tip”

. LEARNED THE CLEANING PROCESS FOR THE

. COVERED THE PROCESS FOR CLEANING THE

. REVIEWED THE DO’s DON'T OF THIS VERY

If dirt or dust is trapped on the Mirrors

or Lens, the Laser Beam can build up

heat on it and finally crack or pit the

surface.

Figure 2

Cleaning Optics

2. Lens
A) The Lens must be
cleaned on both sides
of the optic.
B) The Combiner
Lens is the first Lens
that you see, this is
right after where the
beam leaves the
Laser tube.
C) Do not forget to
clean the Laser Tube
Lens and to clean the
Combiner as it sets,
do not remove it to
clean it. You can lose
a lot of power, if this
optic is dirty and,
because the combiner
lens receives the
highest amount of
power it can crack
more easily than the
other Optics.

Figure 2

3.Lens ASSEMBLY
A) The Lens Assembly is
where the focal Lens is
mounted, check where it
aligns to before removing.
B) You must release the
Lens Assembly from the
Lens Carriage that it rides
on by removing the
Nozzle and air hook up
with the collar ring screw.
C) Once out, use the
Lens removal tool and
unscrew the Capture
Screw and remove the
Lens and rubber gasket.
Clean and replace in the
same place (Curved top of
lens down in the assembly
and up toward the beam
in the carriage),
remember the end of the
nozzle must be slightly
above the Focus plunger
button, so it will auto-focus
correctly.

Figure 3

4. Mirrors

A) All Mirrors except
the last mirror or the
Lens mirror must be
cleaned as they sit.
B) The Last Mirror
can be removed to
clean and then
replaced, using the
Mirror removal tool.
C) The Mirror must
NOT be at an angle.
It must be perfectly
Flat, so the beam
hits the focus lens
and the material
straight. Clean the
Optics from once a
day to once every 2
weeks.

Figure 4

Key Steps to our Goal

Cleaning Optics on Your Tips for Cleaning Optics
A) Pad the Optic with the wet Kim
wipe to collect particles

Laser

A) Cleaning Solution: Camera

cleaner or Acetone in a emergency

B) Use Lid-Free cloths like KIM-

B) Rub the optic with another area of

the cloth that is wet with Lens

Cleaner

Wipes and Industrial wood handled

Q-tips

C) You will remove Only the Carriage
Mirror to clean it

C) Clean Optics as you need to, but
usually once a Week to once every
two Weeks.

D) DO NOT remove the Mirrors to

[EEL RG]

it

D) You will remove the Lens to clean

E) Rounded end of the Len is up

i, torward the beam, when replaced

WATCH FOR THIS:

Cabinet Dust

Figure 1

A) If we have alot
of Dust or Dirt in
the Cabinet, this is
a problem for the
optics.

B) The Fans will
blow the dust onto
the Optics and
cause issues.

C) You will either
have to Clean the
Optics more or
you will lose one
to damage.

D) The Laser
cannot be in a
Dusty
environment,
Period.




Major
CheckPoints

Beam
Alignment

1. Tube

2.Mirror
Mounts

3.Optics
Replacement

4. Tube
Replacement

Video: F30

1. Tube

A) The main item to
look for from the tube
is how it is mounted.
B) The tube needs to
be mounted about .25
to .5” from the 1st
optic.

C) The levelness of
the tube is critical, if
the tube hits the first
mirror at an angle, the
balance of the beam
alignment will never
be adjusted correctly.
With a Carpenters
level you can check it.
If it has been working
it is more than likely
OK. Remember, we
are bouncing a laser
beam off mirrors to
get it to the focus lens
and then to the
material.

Figure 1

oA

N

Figure 3

Doing a Beam

Alignment

Performing a Beam Alignment

Training Data Covered Here:

. LEARNED WHY BEAM ALIGNMENT IS CRITICAL
. LEARNED THE MIRROR MOUNT ALIGNMENT

POINTS.

. LEARNED ABOUT OPTICS REPLACEMENT

. REVIEWED SAFETY PROCEDURES FOR THIS

TASK.

Beam Alignment can render high

“Tip”

productivity or kil it. It is simply

bouncing the Laser Beam off mirrors
until it is delivered to the Focal Lens.

=

MIRRORS

1

LASER TUBE —/

LASER HEAD

=1

MIRRCR BRACKET

Figure 2

2. Mirror Mounts
A) You will see the Red
positioning light on the
mirror, especially when
you put a post-it note or
painters tape on it

B) One thumb screw
adjusts the mirror left/right
and other up/bottom; the
third screw is touched as
a last resort.

C) You adjust the Tube
mirror to shoot to the 2nd
mirror or the Bridge mirror
to start with. These
mirrors have large sweet
spots and should NOT be
dead in the center but
very close. Now adjust
the Bridge Mirror to the
3rd mirror or the Lens
mirror. Lastly, the Lens
mirror should hit the
material straight up &
down by shooting the
burn dot to the center of
the nozzle.

Figure 2

Beam Alignment

3. Optics
Replacement

A) These Optics are very
tough, especially the
Mirrors which have a
thicker coating on them.
B) This is why we do the
Beam alignment to just
little to one side so if we
pit the mirror we can
loosen the capture collar
and rotate the mirror to
keep from replacing it.
C) You replace the Lens

the same way you clean it.

Make sure when replacing
the mirror you tighten the
collar and do a full Beam
alignment. You should
keep a back-up Lens and
mirror in stock. Beam
alignment should only be
done with a tech on the
phone and after you have
watched the BOSS video.

Figure 3

4. Tube
Replacement

A) To replace the tube, just
unplug the laser and open
the tube cover on the cabinet.
B) De-solder or unscrew the
connections to the right / left
of the tube. Mark where it
sets in the holders &
disconnect the hoses.

C) Remove the old tube & put
the new tube in. Attach the
Hoses then the connectors to
the Electrical input. Slide the
tube to your mark left/right &
attach the holding clamps.
Make sure you have silicon
sleeves on the connecter &
over the power end of the
tube. Lastly test fire the tube
and you're ready to start.

Figure 4

Key Steps to our Goal

Tools necessa
optical path

A) Small Post-It notes or Painters

Tape

B) 4" (.25) or thicker piece of acrylic
C) With a Dry Lint free Cloth

D) 2.5mm & 6mm Allen Wrench &

Pliers

E) Patience and Time

to ali

n the Caution

Remember, to use caution, if the

laser is way off target, it could
literally shoot into the room,

missing the mirror, the cabinet

and hitting someone or
something. This could be

dangerous.

Use extra caution on this
procedure.

WATCH FOR THIS:

Tube
Figure 1

NOTE: All machines
go through a QA
process & are already
aligned, ready for use.
So there’s no need for
any adjustments with
the Mirrors - tube -
bracket. The laser
tube and optics are
the heart of the laser
machine. Once tuned
the laser machine
should stay aligned
for months of work.
Check it once every
month to insure no
bumping or
mechanical failure
has occurred.

You can see the
simplicity of the
system: One long
glass tube, two small
mirrors and a laser
head, that’s it. The
light/laser travels in a
straight line, adjusting
the laser tube in the
rear to hit first mirror
(A) Center first, then
adjust mirror (A) to hit
mirror (B) dead
center. And finally
adjust mirror (B) to hit
laser head center. Be
careful with this
procedure. Never
have the machine on
while working around
the laser tube. Make
an adjustment, then
turn on the laser and
fire a test shot by
pressing the LASER
button on the LED
panel.




Major

CheckPoints

Preventative
Maintenance

1. Clean
Optics

2.Clean
Motion
System

3.Cabinet &
Z-Axis

4.Inspection
and Controller

Video: F31

Beam dot size

Lens focal length
15"

207 005"
25" 007"
4.0 012"

1. Clean Optics

A) The main items to
look for from the tube
is how and where it is
mounted.

B) The tube needs to
be mounted about 1/4
to 1/2 inch from the
first optic.

C) The levelness of
the tube is critical, if
the tube hits the first
mirror at an angle the
balance of the beam
alignment will never
be adjusted correctly.
So with a Carpenters
level you can check it.
If it has been working,
it is more than likely
OK. Remember, we
are bouncing a laser
beam off mirrors to get
it to the focus lens and
then to the material.

Figure 1

Figure 3

General Preventative

Maintenance

Performing Preventative Maintenance

Purpose Power output

Tiny image engraving | Increase of power (+7%)

Happy medium for

engraving & cutting
Thicker cutting

Average Power Output

| Decrease of power (-20%) |

Training Data Covered Here:

. REVIEWED WHAT CLEANING IS DONE FOR THE

OPTICS

. PROCESSED THE CLEANING OF THE MOTION

SYSTEM.

. PROCESSED THE CLEANING THE CABINET,

CHILLER AND Z-AXIS.

. REVIEWED THE INSPECTION OF THE

CONTROLLER, ELECTRONICS AND TESTING OF
THE LASER.

“Tip”
The Preventative Maintenance is
designed for you to do. The Bi-Annual
Tune-ups, if you're a long way away
from a Tech, you can go once every 4
years, as long as you do a PC-2-PC
tune-up at 2 years.

Figure 2

Preventative Maintenance

2. Clean Motion

System

A) The Motion system is
the motors, belts and
pulleys that traverse the
Lens Carriage around the
table.

B) With a Clean Cloth
wipe off the Lens
Carriage and the Auto-
Focus Plunger, if you need
to blow them out; remove
the Lens assembly so you
do not blow foreign
material on top of it.

C) Wipe the X Bridge
down and the Left and
Right sides of the Y axis,
both the Rails themselves
and the holder they sit on.
Then put a very thin layer
of Silicon grease on the
rails to protect it from the
pits and the fumes. Do this
Monthly and then jog the
system around the table
then raster (Scan) the
width of the table.

Figure 2

3. Cabinet & Z-Axis
A) Vacuum and Blow out
the Cabinet; for Safety
reasons and to keep dust
off the Optics. You will
need to clean Optics last
after a full PM..

B) Grease the Z-axis lead-
screws that the table
travels up and down on.
Then run the table up and
down to work the Grease
in. This should be a
Quarterly task.

C) Check all the hosing
through the cabinet for
both the tube and Chiller.
The Distilled Water for
the Chiller needs to be
replaced every 6 months.
Also check that the chiller
is @ 22-18C for its
temperature, and you have
no leaks. Putting Tie
Straps on the hose
connections on either side
is a good idea.

Figure 3

4. Inspection and
Controller

A) Unplugged, take a
screwdriver & check the
connections on the
Electronics Board stack.
B) Do a Visual inspection
for items that may be out
of place.

C) Now run a test box to
the table dimensions and
then run the Frame test to
see if all looks square.
Then Laser cut a Vectored
Capital 'L’ place one inch
from the left and 1 inch
from the top of the plate &
test the positioning. Check
your Auto-focus &
checking it the manual
focus tool & adjust it.

Figure 4

Key Steps to our Goal

Major Items for a P.M.

A) Clean Optics

B) Check final Lens mirror for Beam

Alignment

C) Clean Rails and put a light film of

Silicon Grease on rails

Safety

Never do any Preventative

Maintenance with the Laser on or

even Plugged in, and test the unit
prior to doing Maintenance and if

there is a problem afterwards then

review the Maintenance process, it
is the cause of the problem.

D) Remove all Foreign Material from

Cabinet

E) Vacuum out cabinet

F) Inspect Controller and Laser as a

whole

WATCH FOR THIS:

P.M. Checks
Figure 1

Linear bearings:
The linear bearings
are found under
the gantry (to
mount the gantry
to the side rails
and under the focal
head . These
bearings have
grease fittings for
pushing lubricant
into the ball
bearing areas.
1)Remove the
grease fitting, 2)
Apply the grease
to your finger, 3)
Push the grease
into the little hole,
Rubber belts:
The rubber belts
should be checked
for appropriate
tension at least
every six months.
These side belts
work together to
move the gantry
from front to rear.
If the belt appears
to be worn on one
side, check the
bearing alignment
or damage to the
matching bearings.
It is normally a
method of
tightening a screw
and then applying
a lock nut to keep
the screw in place.




Major
CheckPoints

Trouble
shooting 101

1. Eyes and
Ears

2.Software

3.Systems
Check

4.PC-2-PC
Support

N
@)« Video: F32

1. Eyes and Ears

A) When | or the
Technical Support Team
is helping you over the
Phone, remember you
are our Eyes and Ear.
You are at this point a

Tech.

B) Tell the Tech what the
specific problem is, and
even though they may
ask you to repeat steps
you have already done -
repeat them for clarity.
C) To tell us it is “not
working,” is too vague.
- Will the laser turn on?
-Can you test fire the
beam?,

-Can you download from
the PC to the Laser?
-Have you tried another
job?

-Have you tested it in
different spots on the
table. These are big
questions.

Figure 3

Beginners

Training Data Covered Here;

| . STATED THAT YOU ARE THE MAIN TECH, AS YOU
ARE THERE.

2. TALKED ABOUT THE ISSUE OF SOFTWARE AND
THE PC

3. LEARNED ABOUT SYSTEM CHECKS.

4. REVIEWED THE PC-2-PC HOOK UP FOR FAST
SUPPORT.

“Tip”
When TroubleShooting with one of the
Boss Technical Support team; You are
their Eyes and Ears, The more accurate

you are, the faster they can FIGURE
OUT WHAT IS UP.

Figure 1 Figure 2

TroubleShooting for

Performing Simple Troubleshooting

LENS RING NUT DRIVER

FOCUS GUIDE

MIRROR RING NUT DRIVER

TroubleShooting 101

3. Software
A) Software is usually the

main cause of the majority

of problems that an
operator will have.

B) If you can load the last
job that ran fine, and it is
OK -then the problem is
within the Job.

C) If notexit, the
Software and reenter it,
layout a test job from
scratch. If Not restart
Windows, if that does not
do it. Attempt to clean out
all the jobs in the Laser
Que. Now unplug the
USB/Ethernet Cable and
turn the Laser Off, count
to 10 and turn it back on.
Now plug the cable back
in to get the Driver to re-
setup. You may need to
reload LaserWorks and
the USB Driver if you're
having download issues.
Figure 2

3. Systems Check
A) You can check the
system by section, starting
with the system that giving
the main issue.

B) For example if you're
not firing the beam, you
plug in the cheater plug in
your tube power supply
and test fire the laser
bypassing all the inter-
locks.

C) There are Diagnostics
on the Laser Pendant for
check limit switches. An
out bounds can just be
that you can go more to
the center origin to help
with the over travel. You
can get this from running
to fast. Again have myself
or one the factory team on
the horn to run through the
problem and narrow it
down to specific area of
the lasers operation.

Figure 3

4.PC-2-PC Support
A) All PC’s that are
running BOSS Lasers
should be hooked to the
Internet so we can
remote in to do faster
support.

B) | use the Program
www.SHOWMYPC.com
or
WWW.teamviewer.com
to remote in and either
give you training or help
speed up the getting to a
solution.

C) You start the Remote
Dialog, feed us a
Password number one

section at a time . Once
you have done this | will
repeat it back to you to

Figure 4

Key Steps to our Goal

Machine coming on but not

Laser not coming on

*Is it Plugged in?

firing

Problems with any of the Protect

eIs the emergency kill button
pressed?

*Is the key turned to the on
position?

*Check the 120v 5amp fuse located
in the receptacle used to power up
the laser. The fuse is a pull out
type at the bottom of the
receptacle.

*Check the re-settable fuse box
(breaker), make sure the lever is in
the on position. Not all units will
have this fuse.

systems will prevent the laser from
actually firing, although the head will
still move around like the machine is
working fine.

*Check the water supply. If the
laser does not detect water flowing
through the tube the laser will not
fire, so make sure either your water
pump (for LS-1416’s) or CW-
3000/5000 water chiller is on.

*Make sure all doors are closed. All
our machines come with interlocks to

—'». prevent operation in the advent lid or
~doors are open

WATCH FOR THIS:
F.Y.I.
Figure 1

X orY Slop Over
Error / Frame Over

Error When running
the Frame and/or
START-PAUSE
button, the
Slop/Frame error
message will
appear only if the
object(s)/image(s)
being executed on
the worktable is
overextending.
*The file/job keeps
starting at the

same spot
Every time In most

cases, this happens
when the “ORIGIN”
was accidentally
selected. To cancel
the origin, press

the Z/U button and
cycle through the
options until you
see Axis Reset+.
Select it and then
highlight over the X-
Y axis reset. Once
that is selected, the
laser head will go to
it's home position
and now the origin
has been cancelled.
To change the origin
position, just move
the laser head to
your desired
location, then press
the ORIGIN button
again to set the
origin.




Watt Power Speed Scan Gap NOTES

mm/sec DPI
Acrylic 40 75 400 0.05 lower speed or multiple Scan
% www.engraverschoic.com passes to increase depth
Anodized Aluminum 40 75 400 0.07 Scan
Brick 40 85 10 0.10 engrave or cut with lens ~ Scan
. slightly out of focus to
Recommended Engraving and produce glass effect
Cardboard Matt 40 75 400 0.10 Scan
Cutting Settings for 40W Laser g
Ceramic 40 100 200 0.05 Scan
Glass 40 100 200 0.05 Scan
Laserable Plastic 40 50 400 0.05 on plastics with a white Scan
core, you can run the
engraving again at a low
speed to clean the dust.
Leather 40 75 300 0.10 Scan
Marble, Granite 40 100 200 0.05 Scan
This is just a starting point - many different settings can be used MDF - 1/8” 40 75 400 0.10 use transfer tape to Scan
for different effects. Scan gap is very important when engraving prevent scorch
for depth and detail of engraving. To increase productivity, Mirror Back Glass 40 75 300 0.10 Scan
increase speed, power and adjust scan gap proportionately. Painted Metal 40 75 300 0.10 Scan
Paper 40 20 400 0.10 Scan
Rubber Stamp 40 75 300 0.10 use grade engrave to Scan
achieve 3D stamp effect -
set the angle
Sign Foam 40 75 400 0.10 Scan
Wood 40 100 200 0.10 use transfer tape to Scan
prevent scorch
Acrylic - 3mm 1/8” 40 100 5 cut
Materials | Power | Speed DPI Acrylic - 6mm 1/4” 40 100 1 cut
Scan Gap N Otes Acrylic - 12mm 1/2” 40 NR cut
Acrylic - 25mm 1” 40 NR cut
Cardboard Matt 40 50 75 cut
Board
Laserable Plastic 40 75 20 cut
Leather 40 75 10 cut
MDF - 1/8” 40 75 20 cut
Paper 40 50 400 increase speed first / cut
decrease power if
scorching
Rubber Stamp 40 75 10 cut
Wood - 3mm 1/8” 40 100 10 use transfer tape to cut
prevent scorch
Wood - 6mm 1/4” 40 100 5 use transfer tape to cut
prevent scorch
Wood - 9mm 3/8” 40 100 1 use transfer tape to cut
prevent scorch
Wood - 12mm 1/2” 40 NR cut
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% www.engraverschoic.com

Recommended Engraving and
Cutting Settings for 60W Laser

This is just a starting point - many different settings can be used
for different effects. Scan gap is very important when engraving

for depth and detail of engraving. To increase productivity,

increase speed, power and adjust scan gap proportionately.

Materials

Power

Speed

DPI
Scan Gap

Notes

Acrylic

Anodized Aluminum

Brick

Cardboard Matt
Board

Ceramic

Glass

Laserable Plastic

Leather
Marble, Granite
MDF - 1/8”

Mirror Back Glass
Painted Metal
Paper

Rubber Stamp

Sign Foam
Wood

Acrylic - 3mm 1/8”
Acrylic - 6mm 1/4”
Acrylic - 12mm 1/2”
Acrylic - 25mm 1”
Cardboard Matt
Board

Laserable Plastic
Leather

MDF - 1/8”

Paper

Rubber Stamp

Wood - 3mm 1/8”
Wood - 6mm 1/4”
Wood - 9mm 3/8”

Wood - 12mm 1/2”

Watt

60

60
60

60

60
60
60

60
60
60

60
60
60
60

60
60

60
60
60
60
60

60
60
60
60

60

60

60

60

60

Power

50

50
80

50

67
67
35

50
65
50

50
50
20
50

50
65

100
100
100
NR
50

50
50
50
35

50

100

100

100

100

Speed
mm/sec
400

400
25

400

200
200
400

300
200
400

300
300
600
300

400
200

120

20

10

20
400

10
20

10

Scan Gap
DPI
0.05

0.07
0.10

0.05
0.05
0.05

0.10
0.05
0.10

0.10
0.10
0.10
0.10

0.10
0.10

NOTES

lower speed or multiple
passes to increase depth

engrave or cut with lens
slightly out of focus to
produce glass effect

on plastics with a white
core, you can run the

engraving again at a low

speed to clean the dust.

use transfer tape to
prevent scorch

use grade engrave to
achieve 3D stamp effect -
set the angle

use transfer tape to
prevent scorch

increase speed first /
decrease power if
scorching

use transfer tape to
prevent scorch
use transfer tape to
prevent scorch
use transfer tape to
prevent scorch
use transfer tape to
prevent scorch

Scan

Scan
Scan

Scan

Scan
Scan
Scan

Scan
Scan
Scan

Scan
Scan
Scan
Scan

Scan
Scan

cut
cut
cut
cut
cut

cut
cut
cut
cut

cut
cut
cut
cut

cut
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Watt Power Speed Scan Gap NOTES

mm/sec DPI
Acrylic 80 40 400 0.05 lower speed or multiple Scan
% www.engraverschoic.com _ _ passes to increase depth
Anodized Aluminum 80 40 400 0.07 Scan
Brick 80 75 35 0.10 engrave or cut with lens ~ Scan
. slightly out of focus to
Recommended Engraving and produce glass effect
Cardboard Matt 80 40 400 0.10 Scan
Cutting Settings for 80W Laser .o
Ceramic 80 50 200 0.05 Scan
Glass 80 50 200 0.05 Scan
Laserable Plastic 80 25 400 0.05 on plastics with a white Scan
core, you can run the
engraving again at a low
speed to clean the dust.
Leather 80 40 300 0.10 Scan
Marble, Granite 80 50 200 0.05 Scan
o . . . ) MDF - 1/8” 80 40 400 0.10 use transfer tape to Scan
This is just a starting point - many different settings can be used prevent scorch
for different effects. Scan gap is very important when engraving Mirror Back Glass 80 40 300 0.10 Scan
for depth and (cjjetail of engc;avcijr)g.t To increase productivit?/, Painted Metal 80 40 300 0.10 Scan
increase speed, power and adjust scan gap proportionately. '
Paper 80 15 600 0.10 Scan
Rubber Stamp 80 40 300 0.10 use grade engrave to Scan
achieve 3D stamp effect -
set the angle
Sign Foam 80 40 400 0.10 Scan
Wood 80 50 200 0.10 use transfer tape to Scan
prevent scorch
Acrylic - 3mm 1/8” 80 100 30 cut
- Acrylic - 6mm 1/4” 80 100 12 cut
Materials Power Speed DPI Acrylic - 12mm 1/2” 80 100 3 cut
Scan Gap N Otes Acrylic - 25mm 1” 80 100 05 cut
Cardboard Matt 80 50 130 cut
Board
Laserable Plastic 80 40 20 cut
Leather 80 40 10 cut
MDF - 1/8” 80 40 20 cut
Paper 80 30 400 increase speed first / cut
decrease power if
scorching
Rubber Stamp 80 40 10 cut
Wood - 3mm 1/8” 80 100 40 use transfer tape to cut
prevent scorch
Wood - 6mm 1/4” 80 100 15 use transfer tape to cut
prevent scorch
Wood - 9mm 3/8” 80 100 8 use transfer tape to cut
prevent scorch
Wood - 12mm 1/2” 80 100 3 use transfer tape to cut
prevent scorch
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Watt Power Speed Scan Gap NOTES

mm/sec DPI
. Acrylic 90 35 400 0.05 Scan
% www.engraverschoic.com Anodized Aluminum 90 35 400 0.07
Brick 90 70 35 0.10 engrave or cut with lens ~ S¢@n
slightly out of focus to Scan
. produce glass effect
Recommended Eng ravmg and Cardboard Matt 90 35 400 0.10
. . Board Scan
Cutting Settings for 90W Laser ceramic % 45 200 005
Glass 90 45 200 0.05 Scan
Laserable Plastic 90 25 400 0.05 on plastics with a white Scan
core, you can run the Scan
engraving again at a low
speed to clean the dust.
Leather 90 35 300 0.10 Scan
Marble, Granite 90 45 200 0.05 Scan
MDF - 1/8” 90 35 400 0.10 use transfer tape to Scan
This is just a starting point - many different settings can be used prevent scorch
for different effects. Scan gap is very important when engraving Mirror Back Glass 90 35 300 0.10 Scan
for depth and detail of engraving. To increase productivity, Painted Metal 90 35 300 0.10 Scan
increase speed, power and adjust scan gap proportionately. Paper 90 15 600 0.10 Scan
Rubber Stamp 90 35 300 0.10 use grade engrave to Scan
achieve 3D stamp effect -
set the angle
Sign Foam 90 35 400 0.10 Scan
Wood 90 45 200 0.10 use transfer tape to Scan
prevent scorch
Acrylic - 3mm 1/8” 90 100 35 cut
Acrylic - 6mm 1/4” 90 100 15 cut
Materials | Power Speed DPI Acrylic - 12mm 1/2” 90 100 5 cut
SteEm N ofes | Acyic-25mm1 90 100 0.7 out
Cardboard Matt 90 50 150 cut
Board
Laserable Plastic 90 35 20 cut
Leather 90 35 10 cut
MDF - 1/8” 90 35 20 cut
Paper 90 25 400 increase speed first / cut
decrease power if
scorching
Rubber Stamp 90 35 10 cut
Wood - 3mm 1/8” 90 100 45 use transfer tape to cut
prevent scorch
Wood - 3mm 1/8” 90 100 45 cut
Wood - 6mm 1/4” 90 100 20 cut
Wood - 9mm 3/8” 90 100 10 cut
Wood - 12mm 1/2” 90 100 5 cut
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% www.engraverschoic.com

Recommended Engraving and
Cutting Settings for100WLaser

This is just a starting point - many different settings can be used
for different effects. Scan gap is very important when engraving

for depth and detail of engraving. To increase productivity,

increase speed, power and adjust scan gap proportionately.

Materials Power Speed DPI

Scan Gap

Notes

Acrylic

Anodized Aluminum
Brick

Cardboard Matt
Board

Ceramic
Glass
Laserable Plastic

Leather
Marble, Granite
MDF - 1/8”

Mirror Back Glass
Painted Metal
Paper

Rubber Stamp

Sign Foam
Wood

Acrylic - 3mm 1/8”
Acrylic - 6mm 1/4”
Acrylic - 12mm 1/2”
Acrylic - 25mm 1”
Cardboard Matt
Board

Laserable Plastic
Leather

MDF - 1/8”

Paper

Rubber Stamp

Wood - 3mm 1/8”
Wood - 6mm 1/4”
Wood - 9mm 3/8”

Wood - 12mm 1/2”

Watt

100

100
100

100

100
100
100

100
100
100

100
100
100
100

100
100

100
100
100
100
100

100
100
100
100

100

100

100

100

100

Power

30

35
65

30

40
40
25

30
40
30

30
30
NR
30

30
40

100
100
100
100
50

20
30
30
20

30

100

100

90

100

Speed
mm/sec
400

400
35
400

200
200
400

300
200
400

300
300

300
400
200

40
15

160

20

10

20
400

10
50
20

10

Scan Gap

DPI
0.05

0.07

0.10

0.10

0.05
0.05
0.05

0.10
0.05
0.10

0.10
0.10

0.10

0.10
0.10

NOTES

lower speed or multiple
passes to increase depth

engrave or cut with lens

slightly out of focus to
produce glass effect

on plastics with a white

core, you can run the

engraving again at a low
speed to clean the dust.

use transfer tape to
prevent scorch

use grade engrave to

achieve 3D stamp effect -

set the angle

use transfer tape to
prevent scorch

increase speed first /
decrease power if
scorching

use transfer tape to
prevent scorch
use transfer tape to
prevent scorch
use transfer tape to
prevent scorch
use transfer tape to
prevent scorch

Scan

Scan
Scan

Scan

Scan
Scan
Scan

Scan
Scan
Scan

Scan
Scan
Scan
Scan

Scan
Scan

cut
cut
cut
cut
cut

cut
cut
cut
cut

cut
cut
cut
cut

cut
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Watt Power Speed Scan Gap NOTES

mm/sec DPI
Acrylic 120 25 400 0.05 lower speed or multiple Scan
% www.engraverschoic.com passes to increase depth
Anodized Aluminum 120 35 400 0.07 Scan
Brick 120 50 35 0.10 engrave or cut with lens Scan
. slightly out of focus to
Recommended Engraving and produce glass effect
Cardboard Matt 120 25 400 0.10 Scan
Cutting Settings for130WLaser &=
Ceramic 120 35 200 0.05 Scan
Glass 120 35 200 0.05 Scan
Laserable Plastic 120 25 600 0.05 on plastics with a white Scan
core, you can run the
engraving again at a low
speed to clean the dust.
Leather 120 25 300 0.10 Scan
Marble, Granite 120 35 200 0.05 Scan
L . . , . MDF - 1/8” 120 25 400 0.10 use transfer tape to Scan
This is just a starting point - many different settings can be used prevent scorch
for different effects. Scan gap is very important when engraving Mirror Back Glass 120 25 300 0.10 Scan
for depth and detail of engraving. To increase productivity, Painted Metal 120 25 300 0.10 Scan
increase speed, power and adjust scan gap proportionately. Paper 120 NR : Scan
Rubber Stamp 120 25 300 0.10 use grade engrave to Scan
achieve 3D stamp effect -
set the angle
Sign Foam 120 25 400 0.10 Scan
Wood 120 35 200 0.10 use transfer tape to Scan
prevent scorch
Acrylic - 3mm 1/8” 120 75 40 cut
. Acrylic - 6mm 1/4” 120 75 15 cut
Materials | - Power | Speed | DPI Acrylic - 12mm 1/2" 120 75 5 out
Scan Gap N Otes Acrylic - 25mm 17 120 75 07 cut
Cardboard Matt 120 NR cut
Board
Laserable Plastic 120 25 20 cut
Leather 120 25 10 cut
MDF - 1/8” 120 25 20 cut
Paper 120 NR increase speed first / cut
decrease power if
scorching
Rubber Stamp 120 25 10 cut
Wood - 3mm 1/8” 120 75 45 use transfer tape to cut
prevent scorch
Wood - 6mm 1/4” 120 75 20 use transfer tape to cut
prevent scorch
Wood - 9mm 3/8” 120 75 10 use transfer tape to cut
prevent scorch
Wood - 12mm 1/2” 120 75 5 use transfer tape to cut
prevent scorch
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Recommended Engraving and
Cutting Settings for150WLaser

This is just a starting point - many different settings can be used
for different effects. Scan gap is very important when engraving

for depth and detail of engraving. To increase productivity,

increase speed, power and adjust scan gap proportionately.

Materials Power Speed DPI

Scan Gap N Otes

Acrylic

Anodized Aluminum
Brick

Cardboard Matt
Board

Ceramic
Glass
Laserable Plastic

Leather
Marble, Granite
MDF - 1/8”

Mirror Back Glass
Painted Metal
Paper

Rubber Stamp

Sign Foam
Wood

Acrylic - 3mm 1/8”
Acrylic - 6mm 1/4”
Acrylic - 12mm 1/2”
Acrylic - 25mm 1”
Cardboard Matt
Board

Laserable Plastic
Leather

MDF - 1/8”

Paper

Rubber Stamp

Wood - 3mm 1/8”
Wood - 6mm 1/4”
Wood - 9mm 3/8”

Wood - 12mm 1/2”

Watt

150

150
150

150

150
150
150

150
150
150

150
150
150
150

150
150

150
150
150
150
150

150
150
150
150

150

150

150

150

150

Power

20

20
40

20

25
25
20

20
25
20

20
20
NR
20

20
25

60
60
60
60
NR

20
20
20
NR

20

60

60

60

60

Speed
mm/sec
400
400
35
400

200
200
600

300
200
400

300
300

300
400
200

40
15

0.7

20
10
20

10
45

20

10

Scan Gap
DPI

0.05
0.07
0.10

0.10

0.05
0.05
0.05

0.10
0.05
0.10

0.10
0.10

0.10

0.10
0.10

NOTES

lower speed or multiple
passes to increase depth

engrave or cut with lens
slightly out of focus to
produce glass effect

on plastics with a white
core, you can run the

engraving again at a low

speed to clean the dust.

use transfer tape to
prevent scorch

use grade engrave to
achieve 3D stamp effect -
set the angle

use transfer tape to
prevent scorch

increase speed first /
decrease power if
scorching

use transfer tape to
prevent scorch
use transfer tape to
prevent scorch
use transfer tape to
prevent scorch
use transfer tape to
prevent scorch

Scan

Scan
Scan

Scan

Scan
Scan
Scan

Scan
Scan
Scan

Scan
Scan
Scan
Scan

Scan
Scan

cut
cut
cut
cut
cut

cut
cut
cut
cut

cut
cut
cut
cut

cut
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PHONE SERVICE & SUPPORT

FOR YOUR SHOP
One Year of Phone & PC2PC Support to your

Shop for all Lasers, CNC Engravers, Routers &
Sandblasters for Corel, XGW, and Cadlink,
Engravelab, LaserCut, & More!

$25 incidentfee"$1 75 for the Year——1 St Ca" Fl’ee

Installs

|va
2-day installs =$1000 Plus Travel

Required Pre-testing of Unit via Phone or PC!
Training on Corel & Engravelab as well as
LaserCut, Laser and Controller Operations +
PM and Troubleshooting & Material A pI|cat|ons
-
COREL

Software <z

$250 for Full CorelDRAW or Engravelab
Video Training Courses (Jump Drives 100+ &
3 PDF Manuals). $290 for PC2PC Training
Sessions, $800 for Onsite or Classroom full
courses...

Tune-Ups & More

$900 Tune-up onsite Fee + Travel, $280 for PC2PC
repairs--Fast Turn-around of Parts. Call about Applications,
Pricing, and General Engraving Knowledge, whatever your
needs are. We get the majority of our parts direct...

PH:949-355-4000 SEMTE

Q

Splnla Mourt B

Zhde Mo

10-2 Sat;:;_ :

Laser Engravers: support
of Hardware, Software
and Interfaces for all
Makes & Models of
Laser (Galvo & C02.)

UNIVERSAL

Rotary-CNC Engravers;

We support all
applications including
Pricing, Sourcing
Materials and More!

Sandblasting, Film
Applications, Printing
and Software, as well as
Materials and Laser
interface...

IKONICS IMAGING'

Engraver's

choic
SST

oo
COREL"
< Tralning

b Jﬁéa of
. o - “CorelDr e
oIDHAW -/Q> 19483554000
-, el
g S }/ <

Full Corel & EngraveLab Training
Available With Yideo Training Counrse

Customer
atisfaction




Corel Keyboard Overlay

A
\ |
Alt; Lingar Lens Exi Position Rotate Scale Size Macro Edit  Align/Baseline
Ctrl: View Manager Graphic/Text ~ Symbol Manager  Envelope  Convert Para. Text Contour TextEditing  Insert Sym. Char.  Spell Check
ZoomOneShot ~ ZoomQOut  Zoomto Page Freehand Rectangle Elipse Text FubScreen Preview ~ MPU Table Offsets  Fountain Fil  Qutiine Tool
F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12
Corel Draw. Joe Braga 949-355-4000 Joe@Coreldrawtraining.com

All the Fast Keys for Corel

Alt; Lingar Lens Exi Position Rotate Scale Size Macro Edit  Align/Baseline
Ctrl: View Manager Graphic/Text ~ Symbol Manager  Envelope  Convert Para. Text Contour TextEditing  Insert Sym. Char.  Spell Check
ZoomOneShot ~ ZoomQOut  Zoomto Page Freehand Rectangle Elipse Text FubScregn Preview ~ MPU Table Ofsets  Fountain Fil  Qutiine Tool
F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12
Corel Draw. Joe Braga 949-355-4000 Joe@Coreldrawtraining.com

Corel Training Basic-l 2015
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EngravelLab

Keyboard Overlay

Shift:_Context Simplify Inverse ZOOM IN
Alt: Help selected Qsellect*
none
Ctrt: Disable Paletie  Solact all Z00M  ZOOM OUT . Z00M ZOOM ZOOM Setfect Pam
Heb But target fill elect a Refresh UT o Selected to Plate Toggle Menu Bar to Mouse
F1 F2 F3 F4 F5 F6 F F8 F9 F10 F11 F12
EngravelLab Joe Braga 949-355-4000

All the Fast Keys

f()r EngravelLab

Shift:_Context Simplify Inverse ZOOM IN
Alt: Help selected Qsellect*
none
Ctrt: Disable Paletie  Solact all Z00M  ZOOM OUT . Z00M ZOOM ZOOM Setfect Pam
Heb But target fill elect a Refresh UT o Selected to Plate Toggle Menu Bar to Mouse
F1 F2 F3 F4 F5 F6 F F8 F9 F10 F11 F12
EngravelLab Joe Braga 949-355-4000

EngraveLabTraining Basic-1 2015
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